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Preface

Radiation and nuclear decay may be taught as a part of a chemistry, physics, or environmental
science course. This book is designed to be used as a special unit in any such course. Computers,
handhelds, and calculators are an integral and indispensable equipment component in a science
laboratory, and these experiments provide a way to offer hands-on radiation experiments using
this technology.

This book contains six student experiments using a computer with an interface and Logger Pro
software for data collection. The same experiments can also be performed using a
Vernier LabQuest or graphing calculators from Texas Instruments. Either a Vernier LabPro or a
TI CBL 2 interface can be used with the calculator software called DataRad. The original
CBL™ interface is not supported in these experiments.

The experiments were written for the Vernier Radiation Monitor, but, with minor adjustments,
may be performed using the Vernier Digital Radiation Monitor, a Vernier Radiation Monitor, or a
Student Radiation Monitor. These units are Geiger detectors, detecting the presence of ionizing
radiation without measuring energy. The Vernier Radiation Monitor, Digital Radiation Monitor,
and Radiation Monitor are sensitive to alpha particles, while the Student Radiation Monitor is not.
Otherwise, the sensors are equivalent for these experiments. For additional information about the
differences between these detectors, see Appendix B.

Following each student experiment, there is an extensive Instructor Information section with
sample results, answers to questions, directions for preparing equipment, and other hints
regarding the planning and implementation of the experiment.

Experiments in this book can be used unchanged or they can be modified using the word-
processing files provided on the CD that accompanies this book. Students will respond differently
to the design of the experiments, depending on teaching styles of their instructors, math
background, previous experience using data-collection technology, and the scope and level of the
physics or chemistry course.

In writing these experiments, I included more detailed instructions than some instructors would
prefer. I also included more questions than some instructors would want to have their students
answer. I realize that some instructors like to give very minimal instructions to their students in
the laboratory. My thinking is that the extra information would be helpful to novice students (and
instructors), and that other instructors can easily edit the extra text. It is much easier and faster to
remove words from the files than it is to create new ones.

Here are some ways to use the experiments in this book:
l Unchanged. You can photocopy the student sheets, distribute them, and ask the students to
follow the procedures as they are printed in this book. Many students will be more
comfortable if most of the steps used in data collection and analysis are included in each
experiment.
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l Slightly modified. The CD accompanying the book is for this purpose. Before producing
student copies, you can change the directions a little to make them fit your particular
teaching circumstances.

l Extensively modified. This, too, can be accomplished using the accompanying CD. Some
instructors will want to decrease the degree of detail in student instructions.

It is important for instructors to read the information presented in the appendixes in the back of
the book. There is valuable information here that can help make you more comfortable with your
initial use of the data-collection software, the interfaces, and Vernier probes. Here is a short
summary of the information available in each appendix:

l Appendix A tells you how to use the word-processing files on the CD.
l Appendix B describes the various radiation monitor models that have been sold by Vernier
and includes information about minor adjustment that you may need to make to the data-
collection procedures if you have older models.

l Appendix C provides instructions on how to transfer data collected on a LabQuest or
TI graphing calculator into Logger Pro on a computer.

l Appendix D describes equipment from Vernier for performing radiation experiments.

I thank Chris and Dave Vernier, Rick Sorensen, Dan Holmquist, John Wheeler, Ian Honohan,
and Garth Upshaw of Vernier Software & Technology for the advice and assistance they
provided.

JEG

jg@vernier.com
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Computer1
α, β, and γ

Nuclear radiation can be broadly classified into three categories. These three categories are
labeled with the first three letters of the Greek alphabet: α (alpha), β (beta), and γ (gamma). Alpha
radiation consists of a stream of fast-moving helium nuclei (two protons and two neutrons). As
such, an alpha particle is relatively heavy and carries two positive electrical charges. Beta
radiation consists of fast-moving electrons or positrons (an antimatter electron).

A beta particle is much lighter than an alpha and carries one unit of charge. Gamma radiation
consists of photons, which are massless and carry no charge. X-rays are also photons, but carry
less energy than gammas.

After being emitted from a decaying nucleus, the alpha, beta or gamma radiation may pass
through matter, or it may be absorbed by the matter. You will arrange for the three classes of
radiation to pass through nothing but a thin layer of air, a sheet of paper, and an aluminum sheet.
Will the different types of radiation be absorbed differently by the air, paper and aluminum? The
question can be answered by considering which radiation type will interact more strongly with
matter, and then tested by experiment.

In this experiment you will use small sources of alpha, beta, and gamma radiation. Follow all
local procedures for handling radioactive materials.

OBJECTIVES
l Develop a model for the relative absorption of alpha, beta, and gamma radiation by matter.
l Use a radiation counter to measure the absorption of alpha, beta, and gamma radiation by
air, paper, and aluminum.

l Analyze count rate data to test for consistency with your model.

MATERIALS
computer
Vernier computer interface
Logger Pro
Vernier Radiation Monitor
paper sheet
polonium-210 0.1µC alpha source
strontium-90 0.1µC beta source
cobalt-60 1µC gamma source
aluminum sheet, about 2 mm thick



Experiment 1

PRELIMINARY QUESTIONS
1. Most nuclear radiation carries energy in the range of a few million electron volts, or MeV

(1 MeV = 106 eV = 1.6 × 1013 J), regardless of its type (alpha, beta, or gamma). This means
that more massive particles generally travel more slowly than light particles. Make a
preliminary guess as to which radiation type will in general interact most strongly with matter,
and therefore would be most strongly absorbed as it passes through matter. Consider electrical
charge, mass and speed. Explain your reasons.

2. Which radiation type do you predict would interact, in general, least strongly with matter, and
so be less absorbed than others? Why?

3. Which radiation type do you predict would have an intermediate level of interaction with
matter? Why?

4. You will be using paper and aluminum sheet metal as absorbers for the radiation. Which
material has the greatest areal density (that is, a density measure in mass per unit area, which
could be measured in g/cm2), and so would present more matter to the passing radiation?
Which material would have less?

5. Is your Radiation Monitor sensitive to all three types of radiation? How can you tell? Devise
a test and carry it out.

PROCEDURE
1. Connect the Radiation Monitor to a DIG port of the computer interface.

2. Prepare the computer for data collection by opening the file “01 Alpha Beta Gamma” from
the Nuclear Radiation w Vernier folder of Logger Pro.

3. To determine the background count rate, move all sources away from the Radiation Monitor.
Click to begin collecting data. While it may appear as if data collection did not start,
Logger Pro is collecting data; it takes 50 s for the number of counts to appear in the meter.
When the number of counts is displayed, record the value in your data table.

4. Using no absorber, place the beta source near the monitor screen of your Radiation Monitor,
with the underside of the disc facing the monitor screen. Note: Place the Radiation Monitor
and the source in approximately the same position each time you collect data. When using an
absorber, place the absorber between the source and the monitor screen. Each time you
collect data, the distance between the Radiation Monitor and the source should be
approximately the same.

Click to begin data collection. Wait for Logger Pro to display the number of counts
and record the value in your data table.

5. Place a single sheet of paper between the beta source and the monitor, and measure the
counts as before. Take care to keep the source in the same position with respect to the
Radiation Monitor. Record the count rate in the appropriate place in the data table.
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6. In a similar manner, determine and record the counts when the following substances used as
an absorber for each of the three sources:
a. a single sheet of paper
b. a single sheet of aluminum

DATA TABLE
Counts in 50 s interval

No shielding Paper shield Aluminum shield

No source (background)

Alpha source

Beta source

Gamma source

ANALYSIS
1. Compare the no-source, or background, count with the no-absorber counts for the sources. Is

the background count number a significant fraction of the counts from the sources? Do you
need to consider a correction for the background counts?

2. Inspect your data. Does the count rate appear to follow your initial guesses for the relative
absorption of the various types of radiation by matter? Be specific, considering which source
should be the most penetrating (least interacting), and which absorber is more difficult to
penetrate.

3. X-rays are photons, just like gamma rays. X-rays carry lower energy, however, and so
historically received a different name. If you have had an X-ray film picture of your teeth
taken by a dentist, the dentist probably placed a lead-lined apron on your chest and lap before
making the X-ray. What is the function of the lead apron? Support any assertion you make
from your experimental data.

EXTENSIONS
1. If you were presented with a safe, but unknown, radiation source, and assuming that it

emitted only one type of radiation, devise a test that would allow you to tentatively identify
the type of radiation as primarily alpha, beta, or gamma. Write instructions for another student
to follow in performing the test.

2. Your monitor detected some radiation even without a source present. Devise a method to
correct for this background radiation. Do the corrected data still agree with your prediction?

Nuclear Radiation with Vernier 1 - 3
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LabQuest1
α, β, and γ

Nuclear radiation can be broadly classified into three categories. These three categories are
labeled with the first three letters of the Greek alphabet: α (alpha), β (beta), and γ (gamma). Alpha
radiation consists of a stream of fast-moving helium nuclei (two protons and two neutrons). As
such, an alpha particle is relatively heavy and carries two positive electrical charges. Beta
radiation consists of fast-moving electrons or positrons (an antimatter electron).

A beta particle is much lighter than an alpha and carries one unit of charge. Gamma radiation
consists of photons, which are massless and carry no charge. X-rays are also photons, but carry
less energy than gammas.

After being emitted from a decaying nucleus, the alpha, beta or gamma radiation may pass
through matter, or it may be absorbed by the matter. You will arrange for the three classes of
radiation to pass through nothing but a thin layer of air, a sheet of paper, and an aluminum sheet.
Will the different types of radiation be absorbed differently by the air, paper and aluminum? The
question can be answered by considering which radiation type will interact more strongly with
matter, and then tested by experiment.

In this experiment you will use small sources of alpha, beta, and gamma radiation. Follow all
local procedures for handling radioactive materials.

OBJECTIVES
l Develop a model for the relative absorption of alpha, beta, and gamma radiation by matter.
l Use a radiation counter to measure the absorption of alpha, beta, and gamma radiation by
air, paper, and aluminum.

l Analyze count rate data to test for consistency with your model.

MATERIALS
LabQuest
LabQuest App
Vernier Radiation Monitor
paper sheet
polonium-210 0.1µC alpha source
strontium-90 0.1µC beta source
cobalt-60 1µC gamma source
aluminum sheet, about 2 mm thick



Experiment 1

PRELIMINARY QUESTIONS
1. Most nuclear radiation carries energy in the range of a few million electron volts, or MeV

(1 MeV = 106 eV = 1.6 × 1013 J), regardless of its type (alpha, beta, or gamma). This means
that more massive particles generally travel more slowly than light particles. Make a
preliminary guess as to which radiation type will in general interact most strongly with matter,
and therefore would be most strongly absorbed as it passes through matter. Consider electrical
charge, mass and speed. Explain your reasons.

2. Which radiation type do you predict would interact, in general, least strongly with matter, and
so be less absorbed than others? Why?

3. Which radiation type do you predict would have an intermediate level of interaction with
matter? Why?

4. You will be using paper and aluminum sheet metal as absorbers for the radiation. Which
material has the greatest areal density (that is, a density measure in mass per unit area, which
could be measured in g/cm2), and so would present more matter to the passing radiation?
Which material would have less?

5. Is your Radiation Monitor sensitive to all three types of radiation? How can you tell? Devise
a test and carry it out.

PROCEDURE
1. Connect the Radiation Monitor to a DIG port of LabQuest. Choose New from the File menu.

2. Set up the data-collection mode.
a. On the Meter screen, tap Mode.
b. Change the data-collection mode to Selected Events and select OK.

3. Determine the background count rate.
a. Move all sources away from the Radiation Monitor.
b. Start data collection to prepare the system for data collection.
c. Tap Keep. Counts are taken for 50 seconds.

4. When the first point has been collected, place the beta source near the monitor screen of your
Radiation Monitor, with the underside of the disc facing the monitor. Note: Place the
Radiation Monitor and the source in approximately the same position each time you collect
data. When using an absorber in later steps, place the absorber between the source and the
monitor screen. Each time you collect data, the distance between the Radiation Monitor and
the source should be approximately the same.
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5. Test the beta radiation source.
a. Tap Keep. Counts are taken for 50 seconds.
b. Place a single sheet of paper between the beta source and the monitor.
c. Tap Keep.
d. Place a single sheet of aluminum between the beta source and the monitor.
e. Tap Keep.

6. Stop data collection.

7. Tap the Table tab to view your data. Record the values in your data table.

8. Tap the Meter tab and repeat Steps 4–7 with the alpha radiation source.

9. Tap the Meter tab and repeat Steps 4–7 with the gamma radiation source. When you have
completed the testing and recording your data, store the radiation sources as directed by your
instructor.

DATA TABLE
Counts in 50 s interval

No shielding Paper shield Aluminum shield

No source (background)

Alpha source

Beta source

Gamma source

ANALYSIS
1. Compare the no-source, or background, count with the no-absorber counts for the sources. Is

the background count number a significant fraction of the counts from the sources? Do you
need to consider a correction for the background counts?

2. Inspect your data. Does the count rate appear to follow your initial guesses for the relative
absorption of the various types of radiation by matter? Be specific, considering which source
should be the most penetrating (least interacting), and which absorber is more difficult to
penetrate.

3. X-rays are photons, just like gamma rays. X-rays carry lower energy, however, and so
historically received a different name. If you have had an X-ray film picture of your teeth
taken by a dentist, the dentist probably placed a lead-lined apron on your chest and lap before
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Experiment 1

making the X-ray. What is the function of the lead apron? Support any assertion you make
from your experimental data.

EXTENSIONS
1. If you were presented with a safe, but unknown, radiation source, and assuming that it

emitted only one type of radiation, devise a test that would allow you to tentatively identify
the type of radiation as primarily alpha, beta, or gamma. Write instructions for another student
to follow in performing the test.

2. Your monitor detected some radiation even without a source present. Devise a method to
correct for this background radiation. Do the corrected data still agree with your prediction?

1 - 4 Nuclear Radiation with Vernier
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Experiment1
α, β, and γ

1. See Appendix A for information about the word-processing files of the student experiments,
as well as any other electronic resources available for this book.

2. Calculator users: If you are collecting data with TI graphing calculators, an application such
as VST Apps or DataRad may need to be installed on the calculators. You can determine
which app you need at www.vernier.com/til/2672

The calculator instructions for this experiment are not intended for use with TI-Nspire
handhelds or computer software. Radiation Monitors cannot be used with color-screen TI-
84 Plus calculators (TI-84 Plus C Silver Edition and TI-84 Plus CE).

3. The absorption model students develop in the first few questions of the experiment is valid
only in broad terms. The actual penetration of radiation can depend strongly on the energy of
the particles, which is not considered in the simple reasoning applied here.

4. The Vernier Radiation Monitor, the Digital Radiation Monitor, and the Radiation Monitor are
sensitive to all three types of radiation. The Student Radiation Monitor is not sensitive to
alpha radiation, and so will not respond at all to the alpha source. Students doing this activity
with the Student Radiation Monitor will thus not be able to study the relative absorption of
alphas. See Appendix B for additional information about the different radiation monitors.

5. The three sources are commonly sold as small plastic discs, with the radioactive material
embedded within the plastic. Note that the alpha source has an open window on the
underside of the disc. Because alphas are so strongly absorbed, this open window must face
the detector during the experiment.

6. Since the alpha source, polonium-210, has a half-life of 138 days, it must be replaced
regularly. A source purchased years ago will be dead. You can test your source with the
Vernier Radiation Monitor, the Digital Radiation Monitor, and the Radiation Monitor (but not
the Student Radiation Monitor). Measure the background count in a 50 s interval. Place the
open side of the source right next to the screen of the monitor, and measure the counts again.
You should get at least three times the background count rate for a useable source.

7. The activity does not ask students to correct for background counts, since the count rate with
sources will be so large. You may want to ask students to correct their measurements for the
background counts.

8. Sources are available from these suppliers:
l Spectrum Techniques: voice: (865) 482-9937, fax: (865) 483-0473,
www.spectrumtechniques.com

l Flinn Scientific: voice: (800) 452-1261, fax: (866) 452-1436, www.flinnsci.com

INSTRUCTOR INFORMATION



Experiment 1

DATA TABLE
No shielding Paper shield Aluminum shield

No source 15

Alpha source 52 16 14

Beta source 10691 9904 24

Gamma source 4803 4503 2766

Note: If a Student Radiation Monitor is used, the alpha count rates will be zero.

ANSWERS TO PRELIMINARY QUESTIONS
1. Compared to betas and gammas, alpha particles are most likely to be absorbed by matter. We

might expect that the absorption is large because they have the highest electrical charge, and
for a given energy, are moving relatively slowly because of their large mass.

2. Compared to alphas and betas, gammas are least likely to be absorbed by matter. Again, we
might expect that the absorption is smaller because they have no charge and move at the
speed of light.

3. We expect beta radiation to be absorbed at a rate between that of alphas and gammas, since
beta rays have less charge and move faster than alphas, and since gammas have no charge.

4. Compared to paper, the aluminum has the greater areal density. As a result, an aluminum
sheet should be more strongly absorbing of radiation than a sheet of paper.

5. Answer will depend on the monitor used. The Vernier Radiation Monitor, the Digital
Radiation Monitor, and the Radiation Monitor are sensitive to all three types; the Student
Radiation Monitor is sensitive only to beta and gamma radiation.

ANSWERS TO ANALYSIS QUESTIONS
1. The count rate with no source (the background count rate) is much smaller than the count rate

with a source. As a result, the correction is insignificant.

2. Yes, the data are consistent with predictions. Judging from the gamma data, the aluminum
absorbs more than did the paper, which itself absorbed more than the thin layer of air between
the source and the monitor. We expect that the alpha radiation would be most strongly
absorbed, then beta, and finally gamma radiation would be the least absorbed. The alpha
radiation was stopped by even one sheet of paper. The beta radiation was not stopped by the
paper, but was stopped by the aluminum. The gamma radiation was strongly attenuated by
the aluminum sheet, but passed easily through air and paper.
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3. Since a relatively light aluminum sheet absorbed part of the gamma rays, a heavy lead apron
should absorb much of the X-ray radiation. The apron thus shields the patient from X-ray
exposure to the torso and pelvis.

ANSWERS TO EXTENSIONS
1. To determine the type of radiation (alpha, beta, or gamma), first determine the background

count rate, then the source count rate with no absorber. Next, place a sheet of paper between
the source and the monitor. If the counts are significantly reduced, the source emits alpha
particles. If the count rate is not significantly reduced, place a 2 mm thick sheet of aluminum
between the source and the monitor. If the count rate goes almost to the background level, the
source is emitting beta particles. If the count rate is only reduced, the source is a gamma
source.

2. One way to correct for background counts is to measure the background count rate several
times to obtain an average value. Subtract this value from each of the other counts, replacing
any negative numbers with zero. Some variation is to be expected with small count rates (see
the "Counting Statistics" activity for more information). The background correction does not
change any conclusions.
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Computer2
Distance and Radiation

Scientists and health care workers using intense radiation sources are often told that the best
protection is distance; that is, the best way to minimize exposure to radiation is to stay far away
from the radiation source. Why is that?

A physically small source of radiation, emitting equally in all directions, is known as a point
source. By considering the way radiation leaves the source, you will develop a model for the
intensity of radiation as a function of distance from the source. Your model may help explain
why users of radiation sources can use distance to reduce their exposure.

In this experiment you will use a small source of gamma radiation. Gamma rays are high-energy
photons. If your source behaves as a point source, and if the air absorbs little or none of the
gamma radiation, then the radiation intensity should be described well by your model. Follow all
local procedures for handling radioactive materials.

OBJECTIVES
l Develop a model for the distance-dependence of gamma radiation emitted from a point
source.

l Use a counter to measure radiation emitted by a gamma source as a function of distance.
l Analyze count rate data in several ways to test for consistency with the model.

MATERIALS
computer
Vernier computer interface
Logger Pro
Vernier Radiation Monitor
cobalt-60 1µC gamma source
meter stick

PRELIMINARY QUESTIONS
1. Place your cobalt-60 source on a table. Connect the Radiation Monitor to a DIG port on your

interface and start the data-collection software if it doesn't start automatically. The LED on
the Radiation Monitor flashes as the monitor detects radiation. The LED will flash more
quickly when the monitor detects higher radiation level. Using this information and the
cobalt-60 source, determine the most sensitive place on the detector. That is, roughly where
inside the monitor case is the radiation being detected?



Experiment 2

2. Starting about a meter from your source, slowly move the monitor closer to the source until
they nearly touch. How does the flash rate vary with distance from the source? Would you
say that the flash rate is proportional to distance from the source? Or is it an inverse
relationship?

3. Sketch a qualitative graph of the flash rate vs. distance from the source.

4. Suppose a small radiation source (a point source) is placed at the center of two spheres. The
spheres are transparent to the radiation. One sphere has a radius r, and the other a radius 2r.
N particles leave the source each second and travel outward toward the spheres. How does
the number of particles passing through the inner sphere per unit area compare to the number
per unit area passing through the outer sphere? Solve this problem by considering the
following:
a. How many total particles pass through the first sphere? How many pass through the

second sphere?
b. How do the surface areas of the two spheres compare?

5. From your answer to the previous question, write down an expression for the intensity of
radiation (number of particles passing through a unit area each second) as a function of
distance from a point source. Assume that N particles leave the source each second. This
expression is your model for the way radiation intensity varies with distance. Record your
model in the data table.

6. Is your model consistent with the qualitative sketch you drew in Preliminary Question 3?

PROCEDURE
1. Connect the Radiation Monitor to a DIG port of the computer interface if it isn't already

connected.

2. When your source is far from the Radiation Monitor, the monitor still detects background
counts from cosmic rays and other sources. You will need to correct for this background by
determining the average count rate with no source near the monitor. Prepare the computer for
data collection by opening the file “02a Distance” from the Nuclear Radiation w Vernier
folder. Move all sources at least 2 m from the Radiation Monitor, and click ;
Logger Pro will count for ten, 30 second intervals. Wait 5 minutes for data collection to
complete.

3. After Logger Pro has finished data collection, click once on the graph to make it active.
Notice that the number of counts in each interval varies. This is to be expected since
radioactivity is a random process. Click Stats, , to determine the average number of counts
in an interval. Record the mean value in the data table.
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4. Prepare the computer for data collection by opening the file “02b Distance” from the Nuclear
Radiation w Vernier folder of Logger Pro. One graph is displayed: Corrected Radiation
(counts/int) vs. Distance (m).

5. Enter your correction for the count rate by modifying a column in the Logger Pro data table.
To do this, choose Column Options►Corrected Radiation from the Data menu. The
Equation field will read “Radiation” –0. Change the zero to your average background count
rate. For example, if your average rate was 7.3, your equation should read “Radiation” –7.3.
Click to complete the modification.

6. Place the center of the source 6 cm from the monitor screen of the Radiation Monitor.

7. Click to begin collecting data. Logger Pro will begin counting the number of gamma
photons that strike the detector during each 30 second count interval.

8. After at least 30 seconds have elapsed, click . In the entry field, enter 0.06, which is
the distance in meters from the detector to the center of the source. Complete your entry by
clicking . Data collection will now pause for you to adjust the apparatus.

9. Move the source 0.02 m farther from the source. Click to collect more data, and wait
30 seconds.

10. Click , and enter the new distance of 0.08.

11. In the same way as before, move the source away an additional 0.02 m, click , wait
thirty seconds, and click . Enter the distance in meters. Repeat this process until the
distance is at least 0.24 m or the counts in one 30 second interval drops below ten.

12. Click instead of to end data collection.

DATA TABLE
Model expression

Average background counts

ANALYSIS
1. Inspect your graph. Does the count rate appear to follow your model?

2. Fit an appropriate function to your data. To do this, click once on the graph to select it, then
click Curve Fit, . Select an equation that has the same mathematical form as your model
from the equation list, and then click . A best-fit curve will be displayed on the graph.
If your data follow the model, the curve should closely match the data. If the curve does not
match well, try a different fit and click again. When you are satisfied with the fit,
record the fit equation and parameters in the data table and click .
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3. Print or sketch your graph.

4. From the evidence presented in your two graphs, does the gamma radiation emitted by your
source follow your model? Does the relationship seem to fail at larger or smaller distances?

EXTENSIONS
1. Replot your data using a suitable transformation of the x-coordinate so that the resulting plot

should be linear if the data follow your model. For example, if your model were an inverse-
cube function, replot the data using the inverse-cube of the distance values for the horizontal
axis. Do your data follow the model well using this test?

2. Why were you instructed to place the source no closer than 0.06 m from the detector? Repeat
the experiment, using distances of 0, 0.02, 0.04… out to 0.24 m. Hint: Is the detector a
spherical surface?

3. Use a longer counting interval so that you collect at least 300 counts at 0.06 m. Is the
agreement with the inverse-square relationship any different? Try a much shorter count
interval. How is the resulting graph different? Why?

4. Sometimes the table surface can scatter gamma rays, interfering with data collection. Use a
ring stand or other support to hold the sample above the monitor, so that there are no surfaces
near the source. Repeat data collection. Do your data agree any better with your model?

2 - 4 Nuclear Radiation with Vernier



Nuclear Radiation with Vernier © Vernier Software & Technology 2 - 1

LabQuest2
Distance and Radiation

Scientists and health care workers using intense radiation sources are often told that the best
protection is distance; that is, the best way to minimize exposure to radiation is to stay far away
from the radiation source. Why is that?

A physically small source of radiation, emitting equally in all directions, is known as a point
source. By considering the way radiation leaves the source, you will develop a model for the
intensity of radiation as a function of distance from the source. Your model may help explain
why users of radiation sources can use distance to reduce their exposure.

In this experiment you will use a small source of gamma radiation. Gamma rays are high-energy
photons. If your source behaves as a point source, and if the air absorbs little or none of the
gamma radiation, then the radiation intensity should be described well by your model. Follow all
local procedures for handling radioactive materials.

OBJECTIVES
l Develop a model for the distance-dependence of gamma radiation emitted from a point
source.

l Use a counter to measure radiation emitted by a gamma source as a function of distance.
l Analyze count rate data in several ways to test for consistency with the model.

MATERIALS
LabQuest
LabQuest App
Vernier Radiation Monitor
cobalt-60 1µC gamma source
meter stick

PRELIMINARY QUESTIONS
1. Place your cobalt-60 source on a table. Connect the Radiation Monitor to a DIG port on your

interface and start the data-collection software if it doesn't start automatically. The LED on
the Radiation Monitor flashes as the monitor detects radiation. The LED will flash more
quickly when the monitor detects higher radiation level. Using this information and the
cobalt-60 source, determine the most sensitive place on the detector. That is, roughly where
inside the monitor case is the radiation being detected?

2. Starting about a meter from your source, slowly move the monitor closer to the source until
they nearly touch. How does the flash rate vary with distance from the source? Would you
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say that the flash rate is proportional to distance from the source? Or is it an inverse
relationship?

3. Sketch a qualitative graph of the flash rate vs. distance from the source.

4. Suppose a small radiation source (a point source) is placed at the center of two spheres. The
spheres are transparent to the radiation. One sphere has a radius r, and the other a radius 2r.
N particles leave the source each second and travel outward toward the spheres. How does
the number of particles passing through the inner sphere per unit area compare to the number
per unit area passing through the outer sphere? Solve this problem by considering the
following:
a. How many total particles pass through the first sphere? How many pass through the

second sphere?
b. How do the surface areas of the two spheres compare?

5. From your answer to the previous question, write down an expression for the intensity of
radiation (number of particles passing through a unit area each second) as a function of
distance from a point source. Assume that N particles leave the source each second. This
expression is your model for the way radiation intensity varies with distance. Record your
model in the data table.

6. Is your model consistent with the qualitative sketch you drew in Preliminary Question 3?

PROCEDURE
1. Connect the Radiation Monitor to a DIG port of LabQuest if it isn't already connected.

Choose New from the File menu.

2. Set up the data-collection mode.
a. On the Meter screen, tap Mode. Change the data-collection mode to Events with Entry.
b. Change the Count Interval to 300 seconds.
c. Select OK.

3. When your source is far from the Radiation Monitor, the monitor still detects background
counts from cosmic rays and other sources. You will need to correct for this background by
determining the average count rate with no source near the monitor. Determine the
background count rate.
a. Move all sources away from the monitor.
b. Start data collection to prepare the system for data collection.
c. Tap Keep. Counts are taken for 300 seconds.
d. Enter 0 to indicate that this is the value for the background count. Select OK.
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e. Stop data collection.
f. Record the average background counts per minute in your data table.

4. Set up the data-collection mode.
a. Tap the Meter tab.
b. On the Meter screen, tap Mode.
c. Change the Count Interval to 60 seconds.
d. Enter the Name (Distance) and the Units (m).
e. Select OK.

5. Place the center of the source 6 cm from the monitor screen of the Radiation Monitor.

6. Start data collection. Tap Keep. The number of gamma photons that strike the detector will be
counted during the 60-second data collection period.

7. After 60 seconds have elapsed, enter 0.06, the distance in meters from the detector to the
center of the source. Save this data pair by selecting OK.

8. Move the source 0.02 m farther from the source. Tap Keep to count for the new distance.
When the data collection period is complete, enter the new distance of 0.08 m and select OK.

9. In the same way as before, move the source an additional 0.02 m out, tap Keep, and wait for
counting to complete. Enter the new distance in meters. Repeat this process until the distance
is at least 0.24 m or the rate drops below 10 counts per minute.

10. Stop data collection.

11. Correct the data for background radiation.
a. Tap the Table tab.
b. Choose New Calculated Column from the Table menu.
c. Enter Corrected count as the Name and cpm as the Units.
d. Select X-A as the Equation.
e. Enter the average background radiation count from Step 3 as the value for A.
f. Select OK to view a graph of corrected counts vs. distance.

DATA TABLE
Model expression

Average background counts

Fit parameters and equation
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ANALYSIS
1. Inspect your graph. Does the count rate appear to follow your model?

2. Fit an appropriate function to your data.
a. On the Graph screen, choose Curve Fit from the Analyze menu.
b. Choose the equation that matches the mathematical form of your model as the Fit

Equation.
c. Record the fit equation and parameters in your data table.
d. Select OK.

3. Print or sketch your graph.

4. From the evidence presented in your two graphs, does the gamma radiation emitted by your
source follow your model? Does the relationship seem to fail at larger or smaller distances?

EXTENSIONS
1. Replot your data using a suitable transformation of the x-coordinate so that the resulting plot

should be linear if the data follow your model. For example, if your model were an inverse-
cube function, replot the data using the inverse-cube of the distance values for the horizontal
axis. Do your data follow the model well using this test?

2. Why were you instructed to place the source no closer than 0.06 m from the detector? Repeat
the experiment, using distances of 0, 0.02, 0.04… out to 0.24 m. Hint: Is the detector a
spherical surface?

3. Use a longer counting interval so that you collect at least 300 counts at 0.06 m. Is the
agreement with the inverse-square relationship any different? Try a much shorter count
interval. How is the resulting graph different? Why?

4. Sometimes the table surface can scatter gamma rays, interfering with data collection. Use a
ring stand or other support to hold the sample above the monitor, so that there are no surfaces
near the source. Repeat data collection. Do your data agree any better with your model?

5. Instead of using one of the built-in curve fits for your data, choose Model from the Analyze
menu to superimpose an equation with exactly the same form as your model on your data.
Does this equation fit your data? Is this a better test of your model? Why?
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Experiment2
Distance and Radiation

1. See Appendix A for information about the word-processing files of the student experiments,
as well as any other electronic resources available for this book.

2. Calculator users: If you are collecting data with TI graphing calculators, an application such
as VST Apps or DataRad may need to be installed on the calculators. You can determine
which app you need at www.vernier.com/til/2672

The calculator instructions for this experiment are not intended for use with TI-Nspire
handhelds or computer software. Radiation Monitors cannot be used with color-screen TI-
84 Plus calculators (TI-84 Plus C Silver Edition and TI-84 Plus CE).

3. Because the radiation monitors detect individual gamma ray arrivals, Poisson statistics apply.
The more counts that arrive in a counting interval, the better the precision. The standard error
of a count of n is n1/2, so do not be surprised to see considerable run-to-run variation in the
long distance counts where n is only 10 or 20. To achieve better precision requires larger
count numbers, and hence longer count intervals. The student files use a 30-second counting
interval as a compromise between good results and a rapid experiment. Better results will
require longer counting intervals.

4. If your radiation monitors have an audio mode (e.g., Digital Radiation Monitors), turning on
the audio function during the Preliminary Activity will provide an auditory indication of
counts in addition to the flash of the LED on the radiation monitor.

5. Sources are available from these suppliers:
l Spectrum Techniques: voice: (865) 482-9937, fax: (865) 483-0473,
www.spectrumtechniques.com

l Flinn Scientific: voice: (800) 452-1261, fax: (866) 452-1436, www.flinnsci.com

INSTRUCTOR INFORMATION
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SAMPLE RESULTS

Note: The computer-based sample data were collected using a Radiation Monitor, while the
calculator data were collected using a Student Radiation Monitor.

DATA TABLE
Model expression I (r) = N/(4π r2)

Average background counts 8.45

ANSWERS TO PRELIMINARY QUESTIONS
1. The screen at the end is the most sensitive spot.

2. Since the rate of flashing of the LED increases sharply with decreasing distance, the intensity
appears to be an inverse function of distance. It is hard to say from the flashes alone if it is
inverse, inverse-square, or otherwise.

3. Sketch should be a decreasing function with distance.
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4. The number of particles passing through a unit area decreases as the inverse of the square of
the distance from the source. The same number of particles pass through each sphere, but the
area of the larger sphere (radius 2r) is four times the area of the smaller sphere (radius r).

5. I(r ) = N/(4πr2), where N is the number of particles leaving the source each second, and I(r) is
the number of particles per second per unit area at a distance r from the source. That is, the
intensity I is an inverse-square function of distance.

6. Yes, this model is also a decreasing function.

ANSWERS TO ANALYSIS QUESTIONS
1. The count rate falls off rapidly with increasing distance. This is consistent with the inverse-

square relationship predicted by the model.

4. The inverse-square function fits the data well, so it appears that the gamma rays do follow the
inverse-square law over the range of distances investigated.

ANSWERS TO EXTENSIONS
1. A graph using the inverse-square of the distance from the source for the horizontal axis

appears proportional, supporting the inverse-square model.

2. At very small distances the entire detector is not a uniform distance from the source, so the
effective distance is larger than the source-to-detector center distance. The count rates will
then be systematically small. This effect is more significant with the Student Radiation
Monitor than with the Radiation Monitor, since the Geiger tube of the former is larger.
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3. Longer counting intervals improve the statistics so there is less interval-to-interval variation.
As a result the data closely follow an inverse-square function. Shorter count intervals result in
more variation, so there is more scatter of points about the inverse-square function.

4. Results will vary. Comparison of different runs is potentially difficult due to counting
statistics unless n is very large. See Experiment 4 for more information on statistics.

5. (calculator only) Using an inverse-square function of y1=A/x2 and adjusting A so that the
curve passes through the first data point produces this graph:

From the excellent agreement we can conclude that the data support the inverse square
model.
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Computer3
Lifetime Measurement

The activity (in decays per second) of some radioactive samples varies in time in a particularly
simple way. If the activity (R) in decays per second of a sample is proportional to the amount of
radioactive material (R ∝ N, where N is the number of radioactive nuclei), then the activity must
decrease in time exponentially:

R(t) = R0e-λt
In this equation λ is the decay constant, commonly measured in s–1 or min–1. R0 is the activity at
t = 0. The SI unit of activity is the becquerel (Bq), defined as one decay per second.

You will use a source called an isogenerator to produce a sample of radioactive barium. The
isogenerator contains cesium-137, which decays to barium-137. The newly made barium nucleus
is initially in a long-lived excited state, which eventually decays by emitting a gamma photon.
The barium nucleus is then stable, and does not emit further radiation. Using a chemical
separation process, the isogenerator allows you to remove a sample of barium from the cesium-
barium mixture. Some of the barium you remove will still be in the excited state and will
subsequently decay. It is the activity and lifetime of the excited barium you will measure.

While the decay constant λ is a measure of how rapidly a sample of radioactive nuclei will decay,
the half-life of a radioactive species is also used to indicate the rate at which a sample will decay.
A half-life is the time it takes for half of a sample to decay. That is equivalent to the time it takes
for the activity to drop by one-half. Note that the half-life (often written as t1/2) is not the same as
the decay constant λ, but they can be determined from one another.

Follow all local procedures for handling radioactive materials. Follow any special use
instructions included with your isogenerator.

OBJECTIVES
l Use a radiation counter to measure the decay constant and half-life of barium-137.
l Determine if the observed time-variation of radiation from a sample of barium-137 is
consistent with simple radioactive decay.

MATERIALS
computer
Vernier computer interface
Logger Pro
Vernier Radiation Monitor
cesium/barium-137 isogenerator 
cut-off paper cup for barium solution
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PRELIMINARY QUESTIONS
1. Consider a candy jar, initially filled with 1000 candies. You walk past it once each hour.

Since you don’t want anyone to notice that you’re taking candy, each time you take 10% of
the candies remaining in the jar. Sketch a graph of the number of candies for a few hours.

2. How would the graph change if instead of removing 10% of the candies, you removed 20%?
Sketch your new graph.

PROCEDURE
1. Prepare a shallow cup to receive the barium solution. The cup sides should be no more than

1 cm high.

2. Connect the Radiation Monitor to a DIG port of the computer interface.

3. Prepare the computer for data collection by opening the file “03 Lifetime” from the Nuclear
Radiation w Vernier folder of Logger Pro.

4. Prepare your isogenerator for use as directed by the manufacturer. Extract the barium solution
into the prepared cup. Work quickly between the time of solution extraction and the start of
data collection in Step 6, because the barium begins to decay immediately.

5. Place the Radiation Monitor next to the cup so that the rate of flashing of the red LED is
maximized. Take care not to spill the solution.

6. Click to begin collecting data. Logger Pro will begin counting the number of gamma
photons that strike the detector during each 30 second count interval. Data collection will
continue for 30 minutes. Do not move the detector or the barium cup during data collection.

7. After data collection is complete, the button will reappear. Set the Radiation Monitor
aside, and dispose of the barium solution and cup as directed by your instructor.

DATA TABLE
Average background counts

fit parameters for Y = A exp ( – C*X ) + B

A

B

C

λ  (min–1)

t1/2 (min)
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ANALYSIS
1. Inspect your graph. Does the count rate decrease in time? Is the decrease consistent with an

activity proportional to the amount of radioactive material remaining?

2. Compare your graph to the graphs you sketched in the Preliminary Questions. How are they
different? How are they similar? Why are they similar?

3. The solution you obtained from the isogenerator may contain a small amount of long-lived
cesium in addition to the barium. To account for the counts due to any cesium, as well as for
counts due to cosmic rays and other background radiation, you can measure the background
count rate from your data. By taking data for 30 minutes, the count rate should have gone
down to a nearly constant value, aside from normal statistical fluctuations. The counts during
each interval in the last 5 minutes should be nearly the same as for the 20 to 25 minute
interval. If so, you can use the average rate at the end of data collection to measure the counts
not due to barium.
a. Select the data on the graph between 25 and 30 minutes.
b. Click Stats, .
c. Record the value the average counts during the interval in your data table. You will use

this value to compare with a curve fit parameter.

4. Fit an exponential function to the first 15 minutes of your data:
a. Select the first 15 minutes of points on the graph.
b. Click Curve Fit, . Select Natural Exponential from the equation list.
c. Click . A best-fit curve will be displayed on the graph. If your data follow the

exponential relationship, the curve should closely match the data. When you are satisfied
with the fit, click .

d. Record the fit parameters A, B, and C in your data table.

5. Print or sketch your graph.

6. From the definition of half-life, determine the relationship between half-life (t1/2, measured in
minutes) and decay constant (λ, measured in min-1). Hint: After a time of one half-life has
elapsed, the activity of a sample is one-half of the original activity.

7. From the fit parameters, determine the decay constant λ and then the half-life t1/2. Record the
values in your data table.

8. Is your value of t1/2 consistent with the accepted value of approximately 2.552 minutes for the
half-life of barium-137?

9. What fraction of the initial activity of your barium sample would remain after 25 minutes?
Was it a good assumption that the counts in the last five minutes would be due entirely to
non-barium sources? How does the curve fit value for B compare to the average count rate
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between 25 and 30 minutes (determined in Step 3)? What does that comparison tell you about
the meaning of the curve fit parameter B?

EXTENSIONS
1. How would a graph of the log of the count rate vs. time appear? Using Logger Pro,

Graphical Analysis, or a spreadsheet, make such a graph. Interpret the slope of the line if the
data follow a line. Will correcting for the background count rate affect the shape of your
graph?

2. Repeat your experiment several times to estimate an uncertainty to your decay constant
measurement.

3. How long would you have to wait until the activity of your barium sample is the same as the
average background radiation? You will need to measure the background count rate carefully
to answer this question.
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LabQuest3
Lifetime Measurement

The activity (in decays per second) of some radioactive samples varies in time in a particularly
simple way. If the activity (R) in decays per second of a sample is proportional to the amount of
radioactive material (R ∝ N, where N is the number of radioactive nuclei), then the activity must
decrease in time exponentially:

R(t) = R0e-λt
In this equation λ is the decay constant, commonly measured in s–1 or min–1. R0 is the activity at
t = 0. The SI unit of activity is the becquerel (Bq), defined as one decay per second.

You will use a source called an isogenerator to produce a sample of radioactive barium. The
isogenerator contains cesium-137, which decays to barium-137. The newly made barium nucleus
is initially in a long-lived excited state, which eventually decays by emitting a gamma photon.
The barium nucleus is then stable, and does not emit further radiation. Using a chemical
separation process, the isogenerator allows you to remove a sample of barium from the cesium-
barium mixture. Some of the barium you remove will still be in the excited state and will
subsequently decay. It is the activity and lifetime of the excited barium you will measure.

While the decay constant λ is a measure of how rapidly a sample of radioactive nuclei will decay,
the half-life of a radioactive species is also used to indicate the rate at which a sample will decay.
A half-life is the time it takes for half of a sample to decay. That is equivalent to the time it takes
for the activity to drop by one-half. Note that the half-life (often written as t1/2) is not the same as
the decay constant λ, but they can be determined from one another.

Follow all local procedures for handling radioactive materials. Follow any special use
instructions included with your isogenerator.

OBJECTIVES
l Use a radiation counter to measure the decay constant and half-life of barium-137.
l Determine if the observed time-variation of radiation from a sample of barium-137 is
consistent with simple radioactive decay.

MATERIALS
LabQuest
LabQuest App
Vernier Radiation Monitor
cesium/barium-137 isogenerator 
cut-off paper cup for barium solution
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PRELIMINARY QUESTIONS
1. Consider a candy jar, initially filled with 1000 candies. You walk past it once each hour.

Since you don’t want anyone to notice that you’re taking candy, each time you take 10% of
the candies remaining in the jar. Sketch a graph of the number of candies for a few hours.

2. How would the graph change if instead of removing 10% of the candies, you removed 20%?
Sketch your new graph.

PROCEDURE
1. Prepare a shallow cup to receive the barium solution. The cup sides should be no more than

1 cm high.

2. Connect the Radiation Monitor to a DIG port of LabQuest. Choose New from the File menu.

3. Set up the data-collection mode.
a. On the Meter screen, tap Duration.
b. Change the data-collection duration to 30 minutes.
c. Enter 30 as the number of samples/minute and select OK.

4. Prepare your isogenerator for use as directed by the manufacturer. Extract the barium solution
into the prepared cup. Work quickly between the time of solution extraction and the start of
data collection in Step 6, because the barium begins to decay immediately.

5. Place the Radiation Monitor next to the cup so that the rate of flashing of the red LED is
maximized. Take care not to spill the solution.

6. Start data collection. The number of gamma photons that strike the detector will be counted
during the data collection period. Do not move the detector or the barium cup during data
collection.

7. As data collection continues a graph will be updated. When collection is complete, a final
graph of radiation vs. time will appear. Set the Radiation Monitor aside, and dispose of the
barium solution and cup as directed by your instructor.
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DATA TABLE
Average background counts

fit parameters for Y = A exp ( – C*X ) + B

A

B

C

λ  (min–1)

t1/2 (min)

ANALYSIS
1. Inspect your graph. Does the count rate decrease in time? Is the decrease consistent with an

activity proportional to the amount of radioactive material remaining?

2. Compare your graph to the graphs you sketched in the Preliminary Questions. How are they
different? How are they similar? Why are they similar?

3. The solution you obtained from the isogenerator may contain a small amount of long-lived
cesium in addition to the barium. To account for the counts due to any cesium, as well as for
counts due to cosmic rays and other background radiation, you can measure the background
count rate from your data. By taking data for 30 minutes, the count rate should have gone
down to a nearly constant value, aside from normal statistical fluctuations. The counts during
each interval in the last 5 minutes should be nearly the same as for the 20 to 25 minute
interval. If so, you can use the average rate at the end of data collection to measure the counts
not due to barium. To do this.
a. Tap and drag across the data on the graph between 25 and 30 minutes.
b. Choose Statistics from the Analyze menu.
c. Record the average (mean) value in your data table. You will use this value to compare

with a curve fit parameter.

4. Fit an exponential function to the first fifteen minutes of your data.
a. Tap and drag from the first point across the graph to the data point that was collected at

15 minutes.
b. Choose Curve Fit from the Analyze menu.
c. Select Natural Exponent as the Fit Equation.
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d. Record the fit parameters A, B, and C in your data table.
e. Select OK view the fitted curve with your data.

5. Print or sketch your graph.

6. From the definition of half-life, determine the relationship between half-life (t1/2, measured in
minutes) and decay constant (λ, measured in min-1). Hint: After a time of one half-life has
elapsed, the activity of a sample is one-half of the original activity.

7. From the fit parameters, determine the decay constant λ and then the half-life t1/2. Record the
values in your data table.

8. Is your value of t1/2 consistent with the accepted value of approximately 2.552 minutes for the
half-life of barium-137?

9. What fraction of the initial activity of your barium sample would remain after 25 minutes?
Was it a good assumption that the counts in the right side of the graph would be due entirely
to non-barium sources?

EXTENSIONS
1. How would a graph of the log of the count rate vs. time appear? Using LabQuest App,

Logger Pro, or a spreadsheet, make such a graph. Interpret the slope of the line if the data
follow a line. Will correcting for the background count rate affect the shape of your graph?

2. Repeat your experiment several times to estimate an uncertainty to your decay constant
measurement.

3. How long would you have to wait until the activity of your barium sample is the same as the
average background radiation? You will need to measure the background count rate carefully
to answer this question.
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Experiment3
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1. See Appendix A for information about the word-processing files of the student experiments,
as well as any other electronic resources available for this book.

2. Calculator users: If you are collecting data with TI graphing calculators, an application such
as VST Apps or DataRad may need to be installed on the calculators. You can determine
which app you need at www.vernier.com/til/2672

The calculator instructions for this experiment are not intended for use with TI-Nspire
handhelds or computer software. Radiation Monitors cannot be used with color-screen TI-
84 Plus calculators (TI-84 Plus C Silver Edition and TI-84 Plus CE).

3. Sources are available from these suppliers:
l Spectrum Techniques: voice: (865) 482-9937, fax: (865) 483-0473,
www.spectrumtechniques.com

l Flinn Scientific: voice: (800) 452-1261, fax: (866) 452-1436, www.flinnsci.com

4. Detailed directions for preparing the isogenerator are not given because the method varies
with manufacturer. You may want to insert the instructions appropriate to your isogenerator
in the Procedure.

5. Students often confuse the decay constant parameter λ with the half-life t1/2. The decay
constant λ is larger for more rapidly decaying elements and has dimensions of time–1, while
the half-life has dimensions of time, and is smaller for more rapidly decaying elements. The
decay constant λ is equal to the fit parameter C in the Natural Exponential fit of Logger Pro
and LabQuest. The two parameters can be related in the following manner. After one half-life
has elapsed, half of the radioactive nuclei have decayed, and so the activity is also cut in half.
From the rate equation we can relate the decay constant to the half life.
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There is sufficient information in the student guide to perform this conversion, although some
students with weak algebra skills may have difficulty with it. You may choose to work
through this step with your students.
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6. The cesium-137 in the isogenerator decays to a metastable state of barium. The metastable
barium decays with a half-life of 2.552 minutes by gamma emission, making this system an
ideal one for studying in the classroom. A 30 minute experimental run covers almost 12 half-
lives, so that the observed activity drops to about 0.3% of the initial value.

7. The lifetime obtained depends strongly on the correct subtraction of background (in this case,
non-barium) counts. As written, the activity instructions call for a 30-minute data collection
period. If time permits, use a 45 or 60 minute period, and measure the count rate for the final
10 or 15 minutes. A longer experiment will ensure that essentially all the barium will have
decayed. The sample data shown here yield a lifetime of 2.50 minutes, but if the background
value obtained during the last 10 minutes of a 60 minute run is used, the lifetime changes to
2.57 minutes.

8. Many isogenerators allow some cesium to leak through into the barium extract solution. The
cesium results in a nearly constant background activity. This background count is often much
larger than the environmental background, and the analysis must take it into account. That is
why the experiment is written to run for 30 minutes. The final 5 minutes of data can be used
to determine the count rate from the combination of cosmic rays and leaked cesium. If you
have an isogenerator that does not leak significant amounts of cesium, you may want to
shorten the experiment to fifteen minutes.

9. In Step 4 of Analysis, students perform a curve fit on only the first 15 minutes of data. This is
important because the fit will sometimes be poorer if all 30 minutes of data are used. The
counts during the first 15 minutes are largely due to the barium, while the counts in the last
15 minutes are mostly from non-barium sources. The many noisy points in the tail of the
exponential may unduly influence a fit of the entire run.

You may want to have students investigate this effect, or to try various selections of data
during the first 15 minutes (e.g., 2–13 minutes, or 5–15). The resulting value for the lifetime
will vary somewhat, giving an indication of the uncertainty of the measurement. Using our
data we get variations about 0.05 minutes around the typical value shown here.

10. Note that the calculator, computer, and LabQuest versions of the activity use different
notation for the fitted equation. Unlike Logger Pro and LabQuest, the calculator program,
DataRad, uses seconds as the x-axis time unit so that the exponential fit parameter must be
converted from s-1 to min-1 (s-1= 60 min-1) to obtain a lifetime in min-1.

11. Alert readers may notice that the Preliminary Questions are the same as those in
Experiment 24, "Capacitors" of Physics with Vernier. This duplication is intentional, as both
the decay in capacitor potential in an RC circuit and radioactive decay are described by
exponential functions. You may wish to call your students’ attention to this.
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Lifetime Measurement

SAMPLE RESULTS

Raw data from calculator and background subtraction step:

Exponential fit to the first 15 minutes of data after background subtraction:
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Experiment 3

ANSWERS TO PRELIMINARY QUESTIONS
Graph is a decaying exponential. The first few values are 1000, 900, 810… (with integer part of
10% taken each time).

Second graph decays more quickly: 1000, 800, 640…

DATA TABLE
Logger Pro (computers) and LabQuest App

Average background counts 17

fit parameters for Y = A exp ( – C*X ) + B

A 554

B 17

C 0.277

λ (min–1) 0.277

t1/2 (min) 2.50

DataRad (calculators)

fit parameters for Y = A exp ( – B*X ) + C

A 7129 cpm

B 0.00444 s-1

C 182 cpm

λ (min–1) 0.266

t1/2 (min) 2.60
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ANSWERS TO ANALYSIS QUESTIONS
1. The count rate decreases in time, falling to less than 10% of the initial value. This is consistent

with activity being proportional to the amount of remaining radioactive material, since as
material decays, less remains, so the activity must decrease.

2. The three graphs have a similar decreasing shape, although the time-axis scale of the barium
data is different from that of the candy graphs. The vertical axes have different units (candy
remaining and counts/interval). They are similar because in each case the decay process
proceeds at a rate proportional to the remaining candies or radioactive nuclei.

6. We start with the rate equation, and then use the definition of the half-life as the time it takes
for the activity to drop to one-half the original value:
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8. The experimental half-life of 2.50 min is close to the accepted value of 2.552 s.

9. After 25 minutes, 0.11% of the original barium activity remains. (e–25*0.272 = 0.0011). Most,
but not quite all, of the original activity has decayed. The assumption that the counts observed
during the last five minutes of data collection are due only to non-barium is reasonable.
Possibly a better background estimate could be obtained by waiting a longer time.

ANSWERS TO EXTENSIONS
1. A graph of ln(counts/interval) vs. time should be a straight line of negative slope. The slope is

–λ, or the negative of the decay constant. If the background has been subtracted, the graph
should be nearly linear. Without background subtraction, the graph will be curved.

2. Results will vary. A collection of lifetime measurements will allow the student to determine a
range of values; the extent of that range is a measure of the uncertainty of the measurement.
The range of data selected will also influence the measurement, as will the value used for the
additive parameter B in the exponential curve fit.

3. Results will depend on the background radiation level. Experiments done at high altitude will
experience larger background count rates due to reduced attenuation of cosmic rays by the
atmosphere. To measure the background rate, change your set up to count with no source
present. Note that the solution obtained from the isogenerator will contain some cesium,
raising the count rate further above background from environmental radiation.
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Computer4
Counting Statistics

Radioactive decays follow some curious rules that are a consequence of quantum mechanics.
Regardless of when a particular nucleus was created, all nuclei of the same species (cobalt-60 in
this experiment) have exactly the same probability of decay. We might expect that the longer a
nucleus has been around, the more likely it is to decay, but that is not what is observed. Even
though the probability that a given nucleus will decay is fixed, there is no way to predict when it
will decay. In this sense the decay process is completely random. Despite this randomness, a
collection of many identical and independent nuclei will exhibit certain predictable behaviors,
such as a consistent average decay rate when measured over a long time.

There are still variations in the average count rate when measured over a shorter time, however.
Suppose we collect data on the number of decays during a five-second interval. We count decays
for five seconds, and then another five, and so forth. If the average number of counts during each
interval is n, then we will find that the standard deviation of the collection of measurements is on
average n1/2. The standard deviation is a measure of how far away, on average, a measurement is
from the mean value. A histogram of the measurements of the number of decays detected each
interval will show the characteristic distribution known as the Poisson distribution.

When the average number of decays each interval is small, such as one or two, then the Poisson
distribution is not symmetric. An asymmetric distribution means that the most common value is
different from the average value. If the average number of decays in each time interval is larger,
such as more than twenty, the shape of the Poisson distribution approaches the shape of the
Normal, or Gaussian, distribution. The Normal distribution is sometimes called the bell-shaped
curve, although there are other distributions that also look like a bell! The Normal distribution is
symmetric, with the average value being identical to the most common value.

In this experiment you will collect data from a source that exhibits an essentially constant decay
rate. Because the lifetime of the source is so long, the average decay rate will not change during
your experiment. The interval-to-interval count rate will vary, however, but in a way consistent
with the Poisson distribution.

OBJECTIVES
l Use a radiation counter to determine the distribution of count rates from a nearly constant-
rate source.

l Compare the distribution of experimental nuclear counting data to the Poisson distribution.
l Observe the gradual transition of count distribution from Poisson statistics to Gaussian
statistics as the average count rate increases.



Experiment 4

MATERIALS
computer
Vernier computer interface
Logger Pro
Vernier Radiation Monitor
cobalt-60 1µC gamma source

PRELIMINARY QUESTIONS
1. Connect the Radiation Monitor to a DIG port on your interface, and start the data-collection

software if it doesn't start automatically. Place the Radiation Monitor about 10 centimeters
from your Co-60 source. When the monitor detects a by-product of a decaying Co-60 nucleus
(a gamma ray, in this case) the red LED flashes. Is there a uniform time between flashes or
does the time vary? By observing the sequence of flashes, can you predict when the next
flash will occur?

2. Now move the source closer to the monitor. Did the average rate of flashes appear to change?
If so, how did it change? Is there any more or less uniformity to the time interval between
flashes compared to the slower rate?

PROCEDURE
1. Connect the Radiation Monitor to a DIG port the computer interface if it is not already

connected.

2. Prepare the computer for data collection by opening the file “04 Statistics” from the Nuclear
Radiation w Vernier folder of Logger Pro. Two graphs are displayed: a histogram of the
count rate and the counts vs. time.

3. Position the Radiation Monitor next to the Co-60 source so that the rate of flashing of the red
LED is maximized.

4. Click to begin collecting data. Logger Pro will begin counting the number of gamma
photons that strike the detector during each one-second count interval. Data collection will
continue for just 30 seconds. Do not move the detector or the source for the remainder of data
collection.

5. After data collection is complete, the button will reappear.

6. To study the variation in count rate distributions, you will need to change the length of one
time interval so that the average number of counts is first small (about 1) and then larger (30
or so). The count rate from your particular source depends on its age and initial activity, so
you will need to first determine the average count rate from your sample. To do this, click the
graph of counts/interval vs. time. Then, click Statistics, , to see the average count rate. Enter
this value in your data table. Now, determine the necessary interval lengths to achieve an
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average of 1 count per interval and an average of 30 counts per interval. Round these values
up to the next 0.05 second. For example, let’s say your average count rate was 4.67 counts
per one-second interval. To get about one count per interval with the same source, you would
use an interval of 4.67-1 or 0.21 seconds, rounded to 0.25 seconds. For 30 counts, multiply
this by 30, getting 6.45 s after rounding up. Enter these values in your data table.

7. Set the counting interval to the value needed to obtain an average count of approximately
one. To do this, choose Data Collection from the Experiment menu. Change the number of
seconds/sample to the low count rate value in you recorded in your data table. Take care not
to use the samples/second field. Then, set the Duration so that 200 samples will be collected
(i.e., enter a value 200 times the seconds/sample time). Click .

8. Click to begin counting. Observe the histogram as data are collected. Is there a regular
pattern as to the next count rate that appears? Do the values appear to be clustered around a
most-common value? When data collection is complete, the button will reappear.

9. After data collection is complete, click the counts vs. time graph to make it active, and then
click Statistics, , to calculate statistics for the data. Record the average and standard
deviation in your data table. Rescale your graph if needed.

10. (optional) Print your screen by choosing Print from the File menu.

11. Set the counting interval to the value needed to obtain an average count of approximately
thirty. To do this, choose Data Collection from the Experiment menu. Change the number of
seconds/sample to the high count rate value you recorded in your data table. Then, set the
Duration so that 200 samples will be collected (i.e., enter a value 200 times the
seconds/sample). Click .

12. Click to begin counting. Observe the histogram as data are collected. Is there a regular
pattern as to the next count rate that appears? Do the values appear to be clustered around a
most-common value? When data collection is complete, the button will reappear.
Rescale your graph as needed.

13. Click the counts/interval vs. time graph to make it active, and then click Statistics, , to
calculate statistics for the data. Record the average and standard deviation in your data table.

14. (optional) Print your screen by choosing Print from the File menu.

15. The standard deviation is a measure of how far away, on average, a typical measurement (of
counts during each interval) is from the average of all the measurements. The interval defined
by (average ± one standard deviation) contains most of the measurements. From your average
and standard deviation values, determine this interval, rounded to the nearest integer. From
the Histogram data table window, determine the fraction of the measurements that fall within
the interval.
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DATA TABLE
Average count rate (1 s interval)

Low count rate (~1/interval) High count rate (~30/interval)

Interval length (s)

Average rate (counts/interval)

Square root (average rate)

Standard deviation (counts/int)

Fraction within ± std dev

ANALYSIS
1. Is your first histogram (with the low average count rate) symmetric? How can you tell? Was

that shape consistent with the Normal distribution?

2. Is your second histogram (with the high average count rate) symmetric? How can you tell? Is
the symmetry of your data distribution consistent with the Normal distribution?

3. Calculate the square root of the average count rate for your low- and high-count-rate trials.
The square root of the number of counts measured in one interval is an estimate of the
standard deviation of a set of measurements, when those measurements follow the Poisson
distribution. How does the square-root estimate compare to the actual standard deviation of
your set of measurements?

4. Use the comparison in the previous question to answer this question: An experiment yields
900 counts in one interval. Predict the standard deviation of a set of 200 additional
measurements made under the same conditions.

5. For your high-count-rate data, is the fraction of the measurements that fall within the interval
close to two-thirds? The Normal distribution is symmetric and has two-thirds of its values
within one standard deviation of the average. Is the distribution of your data consistent with
the Normal distribution?

EXTENSIONS
1. Consult a statistics or nuclear physics reference book to learn the mathematical form of the

Poisson distribution. Plot a Poisson distribution with the same average and standard deviation
as your low-count-rate data on the same graph with those data.
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2. Consult a statistics or nuclear physics reference book to learn the mathematical form of the
Normal distribution. Plot a Normal distribution with the same average and standard deviation
as your high-count-rate data on the same graph with those data.

3. Determine the fraction of your measurements falling with two standard deviations of the
average for the high-count-rate measurements. The Normal distribution includes 90% of the
measurements within two standard deviations of the average.

4. Determine the fraction of your measurements falling with three standard deviations of the
average for the high-count-rate measurements. The Normal distribution includes 99% of the
measurements within two standard deviations of the average.

5. Collect additional data at the high count rate. Use intervals with 500 to 1000 counts. Is the
histogram different in shape from your earlier data?
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Experiment4
Counting Statistics

1. See Appendix A for information about the word-processing files of the student experiments,
as well as any other electronic resources available for this book.

2. This experiment can be done using Logger Pro (computers) and DataRad (calculators).
LabQuest does not support histograms. If you are collecting data with TI graphing
calculators, an application such as VST Apps or DataRad may need to be installed on the
calculators. You can determine which app you need at www.vernier.com/til/2672

The calculator instructions for this lab are not intended for use with TI-Nspire handhelds or
computer software. Radiation Monitors cannot be used with color-screen TI-84 Plus
calculators (TI-84 Plus C Silver Edition and TI-84 Plus CE).

3. The experiment calls for counting times that allow for 200 intervals. This is a minimal
collection time. If 400 to 500 intervals are used, the resulting distributions will be cleaner and
more “like the textbook.” If a fresh 1 µC source is used, the 500-interval count will not take
excessively long. Use 500 intervals if time allows. Consider collecting data overnight for
even better data.

4. If you are using Logger Pro, you may want to have your students collect low-rate and high-
rate data several times to compare the histograms. Particularly if only 200 intervals are used,
the histograms will vary from run to run. If more intervals are used, the histograms will vary
much less from run to run. It is interesting to watch the histogram “grow” during data
collection. You’ll see the pattern start as a very rough pattern as the first few bars appear, and
then as more and more data are collected the pattern will fill in to approximate an ideal
distribution. You may want to have your students observe this during data collection.

5. If your radiation monitors have an audio mode (e.g., Digital Radiation Monitors), turning on
the audio function during the Preliminary Activity will provide an auditory indication of
counts in addition to the flash of the LED on the radiation monitor.

6. Sources are available from these suppliers:
l Spectrum Techniques: voice: (865) 482-9937, fax: (865) 483-0473,
www.spectrumtechniques.com

l Flinn Scientific: voice: (800) 452-1261, fax: (866) 452-1436, www.flinnsci.com

INSTRUCTOR INFORMATION



Experiment 4

SAMPLE RESULTS

Low count rate results with asymmetric histogram:
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High count rate results with symmetric histogram:

ANSWERS TO PRELIMINARY QUESTIONS
1. The time between flashes (events) is not uniform; sometimes it is long, and sometimes it is

very short. There is apparently no way to predict when the next event will occur.

2. There are now more flashes each second, but they are still irregular.
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DATA TABLE
Logger Pro (computer)

Average count rate (1 s interval) 33.7

Low count rate (~1/interval) High count rate (~30/interval)

Interval length (s) 0.017 0.9

Average rate (counts/interval) 0.98 28.9

Square root (average rate) 0.99 5.4

Standard deviation (counts/int) 0.97 5.1

Fraction within ± std dev 70%

DataRad (calculator)

Counts/interval (100 s interval) 2710

Low count rate
(~1/interval)

High count interval
(~30/interval)

Interval length (s) 0.04 1.11

Average rate (cpm) 1504 1550

Average counts 1.00 28.7

Square root (average counts) 1.00 5.3

Standard deviation (cpm) 1612 263.9

Standard deviation (counts) 1.07 4.9

Fraction within ± std dev 80%
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Binmax Number

1105 11

1237 12

1369 49

1501 38

1633 69

1765 28

1897 30

2030 15

2162 8

2294 5

214/265 or 80% of the measurements are within one standard deviation of the average.

ANSWERS TO ANALYSIS QUESTIONS
1. No, the low-count rate histogram is not symmetric. This is apparent from the peak that is left

of center on the distribution. The asymmetric shape is different from the Normal distribution,
so these data are not distributed like the Normal distribution.

2. The second, high-rate, histogram appears symmetric since the peak is in the middle. This
shape is qualitatively similar to the Normal distribution.

3. (4 for calculator) The square root estimates are very close to the actual standard deviations.
This is consistent with the count data following the Poisson distribution.

4. (5 for calculator) The estimated standard deviation of a set of measurements with a 900-count
average would be 9000.5, or 30. That 200 (or 2000) measurements are to be made is not
relevant.

5. (6 for calculator) The fraction of measurements within one standard deviation of the average
is 70%, which is very similar to the expected two-thirds of values within that range for the
Normal distribution. The calculator histogram bins are broader than are the computer bins, so
the higher 80% fraction is due to over counting in the broader bins.
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ANSWERS TO EXTENSIONS
1. Below is a histogram of low-count rate data of average rate three (solid bars) with Poisson

distribution (hatched bars) of same average and area. This graph was created using a
spreadsheet. The distribution of the experimental data and the Poisson distribution are very
similar; both are asymmetric. The expression used to calculate the unit-area Poisson
distribution, where x the counts/interval and µ the average, is









P x µ µ; = −

µ

x e!

x

2. Below is a histogram of high-count rate data (solid bars) with Poisson distribution (hatched
bars) of same average and area. The distribution of the experimental data and the Poisson
distribution are very similar; both are nearly symmetric as expected for data with an average
count rate near thirty.
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3. Approximately 90% of the measurements fall within an interval two standard deviations on
either side of the average. This is consistent with the Normal distribution.

4. Essentially all of the measurements fall within an interval three standard deviations on either
side of the average. This is consistent with the Normal distribution, where 99.7% of the
measurements fall within this range.
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Computer5
Background Radiation Sources

When a Geiger counter is operated it will usually record an event every few seconds, even if no
obvious radioactive source is placed nearby. Where do these counts come from?

Two significant sources are cosmic rays and radon decay products. Cosmic rays, as the name
suggests, are fast-moving particles from space that enter the Earth’s atmosphere, along with their
decay products. Since the atmosphere absorbs some of these particles, the rate of detection of
cosmic rays increases with increasing altitude. If you were to take a Geiger counter on a cross-
country jet flight, you would observe a marked increase in count rate while at high altitude.

Another radiation source comes not from above us, but from below. The Earth’s crust contains,
among other radioactive elements, uranium-238 (238U). 238U has a long half-life, but its decay
products do not. One of these products is radon gas, or 222Rn. As a result of the long uranium
half-life, there is a nearly steady production of radon, which itself decays with a short half-life of
3.8 days. Since radon is a gas, it diffuses out of the soil into the air, and can collect in low
enclosed areas such as basements. Radon decays to a series of species including polonium, lead,
and bismuth. These decay products precipitate out of the air onto dust particles since they are
solids, unlike gaseous radon.

The decay products are also electrically charged, so that it is relatively easy to collect them on a
charged surface for analysis. One simple way to create a charged surface is to rub a balloon with
fur or hair—you have probably done this to stick balloons to the wall using their static charge. If
you allow the balloon to sit undisturbed for 45 minutes or so, it will collect a fresh set of decay
products. The beta and gamma ray emissions as these products themselves decay can be detected
using a Geiger counter.

The 238U decay sequence relevant to this experiment is 222Rn (3.8 d) → 218Po (3.1 min) → 214Pb
(27 min) → 214Bi (20 min) → 214Po (164 µs) →… The times in parenthesis are the half-lives of
each species. Since your Geiger counter is unable to distinguish between the emissions from each
of these decays, you would only be able to measure a composite effect of some of the
components. Nevertheless, if you observe a time-dependent count rate from your balloon, you
will have evidence that there must be a continuous re-supply of the parent radon to the
environment.

OBJECTIVES
l Concentrate naturally occurring radioactive substances using a charged balloon.
l Use a radiation counter to detect emissions from naturally occurring radioactive substances.
l Determine the effective lifetime of the collection of radon decay products.



Experiment 5

MATERIALS
computer
Vernier computer interface
Logger Pro
Vernier Radiation Monitor
toy balloon, hair, or fur for charging
string, 2 m

PRELIMINARY QUESTION
1. Connect the Radiation Monitor to a DIG port on your interface and start the data-collection

software if it doesn't start automatically. The LED on the Radiation Monitor flashes as the
monitor detects radiation. Can you detect any radiation in your laboratory? Do you have any
way to determine what the radiation is coming from?

PROCEDURE
1. Blow up your balloon so that it is firm. Tie the string to the balloon so you can suspend it in

mid-air. Rub the entire surface of the balloon vigorously on the fur for about a minute to give
it a static charge. Test the charge by picking up small bits of paper with the balloon by
bringing it near the paper. The paper should jump to the balloon’s surface and stick there.

2. Suspend the charged balloon away from other objects and where it will not be disturbed. An
enclosed basement room is best. Be sure the balloon is at least 2 m from the Radiation
Monitor. Let the balloon remain in position for 45 minutes.

3. Connect the Radiation Monitor to a DIG port of the computer interface if it isn't already
connected.

4. Prepare the computer for data collection by opening “05 Background” from the Nuclear
Radiation w Vernier experiment files of Logger Pro. One graph is displayed: counts vs. time.
The vertical axis is scaled from 0 to 1000 counts/interval. The horizontal axis is distance
scaled from 0 to 200 minutes.

5. While you are waiting for the balloon to collect its radioactive dust, determine the average
background count rate from cosmic rays and unconcentrated dust. To do this, click
and allow the computer to count events. Every 5 minutes a new point will be added to the
graph.

6. When the balloon still has 5 minutes remaining in its dust collection time, click . To
determine the average background count rate, click once on the graph, and then click
Statistics, . Record the average number of counts for each 5 minute interval in your data
table.
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7. Once the balloon has been in position for 45 minutes, take it down and deflate it. Taking care
not to rub the collected dust from the surface, roll it into a small cylinder. Place the roll as
close as possible to the monitor screen of the Radiation Monitor.

8. Click to begin data collection. Logger Pro may ask you what you want to do; click
Erase and Continue to start data collection. Wait 200 minutes for Logger Pro to complete
data collection.

DATA TABLE
Average background count rate

fit parameters for Y = A exp ( – C*X ) + B

A

B

C

λ (min–1)

t1/2 (min)

ANALYSIS
1. Inspect your graph. Is the count rate from the balloon-concentrated dust greater than the

average background rate you observed? Is the difference significant? Does the count rate
decrease with time? (If the initial count rate is not higher than background, the balloon may
not have collected sufficient radioactive dust for the following analysis to be meaningful.)

2. Fit an exponential function to your data. To do this, click Curve Fit, . Select Natural
Exponent from the equation list, and then click . A best-fit curve will be displayed on
the graph. If your data follow the exponential relationship, the curve should closely match the
data. When you are satisfied with the fit, click .

3. Print or sketch your graph.

4. Record the fit parameters A, B, and C in your data table.

5. From the fit parameters, determine the decay constant λ and the half-life t1/2. Is it necessary to
correct for background counts from cosmic rays? Note that there is an additive constant in the
fitted equation Y = A exp ( – C*X ) + B. How does the additive constant compare to the
background count rate you measured?

6. Is your value of t1/2 consistent with any one half-life of the radon decay products?
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7. What fraction of the initial activity of your sample would remain after five hours, if you were
to continue the experiment for that length of time?

8. Cosmic rays arrive at the Earth’s surface at a roughly constant rate. Do you have evidence of
the presence of a non-cosmic ray source of radiation in your laboratory? Explain.

9. If radon gas is the source of any time-dependent count rates you observed, must there be a
continuous source of fresh radon gas to the environment?

EXTENSIONS
1. Is there a variation in the background radiation count rate in different places in your school?

List several reasons why the rate might vary, or why it might be the same.

2. From the decay sequence given in the introduction, determine the type of nuclear decay
(alpha, beta, or gamma) in each step.

3. Rather than allowing Logger Pro to determine the background count rate with the additive
term of the exponential curve fit, correct the experimental count rates by subtracting the
average background count rate you measured earlier in the experiment. Plot a new graph of
corrected count rate vs. time, and fit a new exponential function to the data. Now that you
have corrected for background counts, what should happen to the fitted value of the additive
constant B in Y = A*exp(–C*X) + B?

4. Create a plot of the natural log of the corrected count rates vs. time. What is the significance
of the slope of a line fitted to the data?

5. Why would you expect a graph of count rate vs. time, such as collected for this experiment, to
not be a simple exponential function?
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LabQuest5
Background Radiation Sources

When a Geiger counter is operated it will usually record an event every few seconds, even if no
obvious radioactive source is placed nearby. Where do these counts come from?

Two significant sources are cosmic rays and radon decay products. Cosmic rays, as the name
suggests, are fast-moving particles from space that enter the Earth’s atmosphere, along with their
decay products. Since the atmosphere absorbs some of these particles, the rate of detection of
cosmic rays increases with increasing altitude. If you were to take a Geiger counter on a cross-
country jet flight, you would observe a marked increase in count rate while at high altitude.

Another radiation source comes not from above us, but from below. The Earth’s crust contains,
among other radioactive elements, uranium-238 (238U). 238U has a long half-life, but its decay
products do not. One of these products is radon gas, or 222Rn. As a result of the long uranium
half-life, there is a nearly steady production of radon, which itself decays with a short half-life of
3.8 days. Since radon is a gas, it diffuses out of the soil into the air, and can collect in low
enclosed areas such as basements. Radon decays to a series of species including polonium, lead,
and bismuth. These decay products precipitate out of the air onto dust particles since they are
solids, unlike gaseous radon.

The decay products are also electrically charged, so that it is relatively easy to collect them on a
charged surface for analysis. One simple way to create a charged surface is to rub a balloon with
fur or hair—you have probably done this to stick balloons to the wall using their static charge. If
you allow the balloon to sit undisturbed for 45 minutes or so, it will collect a fresh set of decay
products. The beta and gamma ray emissions as these products themselves decay can be detected
using a Geiger counter.

The 238U decay sequence relevant to this experiment is 222Rn (3.8 d) → 218Po (3.1 min) → 214Pb
(27 min) → 214Bi (20 min) → 214Po (164 µs) →… The times in parenthesis are the half-lives of
each species. Since your Geiger counter is unable to distinguish between the emissions from each
of these decays, you would only be able to measure a composite effect of some of the
components. Nevertheless, if you observe a time-dependent count rate from your balloon, you
will have evidence that there must be a continuous re-supply of the parent radon to the
environment.

OBJECTIVES
l Concentrate naturally occurring radioactive substances using a charged balloon.
l Use a radiation counter to detect emissions from naturally occurring radioactive substances.
l Determine the effective lifetime of the collection of radon decay products.



Experiment 5

MATERIALS
LabQuest
LabQuest App
Vernier Radiation Monitor
toy balloon, hair, or fur for charging
string, 2 m

PRELIMINARY QUESTION
1. Connect the Radiation Monitor to a DIG port on your interface and start the data-collection

software if it doesn't start automatically. The LED on the Radiation Monitor flashes as the
monitor detects radiation. Can you detect any radiation in your laboratory? Do you have any
way to determine what the radiation is coming from?

PROCEDURE
1. Blow up your balloon so that it is firm. Tie the string to the balloon so you can suspend it in

mid-air. Rub it vigorously on the fur for about a minute to give it a static charge. Test the
charge by picking up small bits of paper with the balloon by bringing it near the paper. The
paper should jump to the balloon’s surface and stick there.

2. Suspend the charged balloon away from other objects and where it will not be disturbed. Be
sure the balloon is at least 2 meters from the Radiation Monitor. Let the balloon remain in
position for 60 minutes.

3. Connect the Radiation Monitor to a DIG port of LabQuest if it isn't already connected.
Choose New from the File menu.

4. Set up the data-collection mode.
a. On the Meter screen, tap Duration.
b. Change the data-collection duration to 45 minutes and the rate to 0.2 samples/minute.

Select OK.

5. Collect background radiation information.
a. Move all sources away from the monitor.
b. Start data collection.
c. After data collection is complete and a graph is displayed, choose Statistics from the

Analyze menu.
d. Record the average background radiation count in cpm in your data table.
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6. Your balloon should have a few minutes left in its dust collection time. Prepare to collect
count data as a function of time.
a. Tap the Meter tab and tap Duration.
b. Change the data-collection duration to 200 minutes and leave the data collection rate as

0.2 samples/minute. Select OK.

7. Once the balloon has been in position for 60 minutes, take it down and deflate it. Taking care
not to rub the collected dust from the surface, roll it into a small cylinder. Place the roll as
close as possible to the monitor screen of the Radiation Monitor.

8. Start data collection. Wait 200 minutes for data collection to complete.

DATA TABLE
Average background count rate

fit parameters for Y = A exp ( – C*X ) + B

A

B

C

λ (min–1)

t1/2 (min)

ANALYSIS
1. Inspect your graph. Is the count rate from the balloon-concentrated dust greater than the

average background rate you observed? Is the difference significant? Does the count rate
decrease with time? (If the initial count rate is not higher than background, the balloon may
not have collected sufficient radioactive dust for the following analysis to be meaningful.)

2. Fit an exponential function to your data.
a. On the Graph screen, choose Curve Fit from the Analyze menu.
b. Select Exponential as the Fit Equation.
c. Record the fit parameters, A, B, and C in your data table.
d. Select OK. If your data follow the exponential relationship, the curve should closely

match the data.

3. Print or sketch your graph.

4. From the fit parameters, determine the decay constant λ and the half-life t1/2.
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5. Is your value of t1/2 consistent with any one half-life of the radon decay products?

6. What fraction of the initial activity of your sample would remain after five hours, if you were
to continue the experiment for that length of time?

7. Cosmic rays arrive at the Earth’s surface at a roughly constant rate. Do you have evidence of
the presence of a non-cosmic ray source of radiation in your laboratory? Explain.

8. If radon gas is the source of any time-dependent count rates you observed, must there be a
continuous source of fresh radon gas to the environment?

EXTENSIONS
1. Is there a variation in the background radiation count rate in different places in your school?

List several reasons why the rate might vary, or why it might be the same.

2. From the decay sequence given in the introduction, determine the type of nuclear decay
(alpha, beta, or gamma) in each step.

3. Create a plot of the natural log of the corrected count rates vs. time. What is the significance
of the slope of a line fitted to the data?

4. Why would you expect a graph of count rate vs. time, such as collected for this experiment, to
not be a simple exponential function?
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Experiment5
Background Radiation Sources

1. See Appendix A for information about the word-processing files of the student experiments,
as well as any other electronic resources available for this book.

2. Calculator users: If you are collecting data with TI graphing calculators, an application such
as VST Apps or DataRad may need to be installed on the calculators. You can determine
which app you need at www.vernier.com/til/2672

The calculator instructions for this experiment are not intended for use with TI-Nspire
handhelds or computer software. Radiation Monitors cannot be used with color-screen TI-
84 Plus calculators (TI-84 Plus C Silver Edition and TI-84 Plus CE).

3. This experiment is based on ideas found in three papers: “Radioactiveball,” by James Cowie,
Jr., and Thomas A. Walkiewicz, The Physics Teacher 30, Jan, 1992, 16, and “The Hot
Balloon (Not Air),” by Thomas A. Walkiewicz, The Physics Teacher 33, Sept., 1995, 344.

4. Since the radon decay products are produced as ions, we collect them electrostatically. The
air must be dry for effective collection. If you cannot charge the balloon to the point that it
will strongly attract hair and dust, it is too humid and you will collect little if any decay
products. You may want to reserve this experiment for a dry winter day. If the count rate
from the concentrated dust is not significantly different from background, then you have not
collected a sufficient quantity of airborne radioactive dust. This could be due to high
humidity, or it could be due to a low local radon concentration. It is possible that you will get
little or no counts above background because radon is not spread evenly in any given region.
You can see a map of potential for radon presence across the United States at
http://energy.cr.usgs.gov/radon/usrnpot.gif

5. It is important to allow the balloon to remain undisturbed for 45 minutes. This time allows the
decay products captured by the balloon to roughly reach secular equilibrium. You will need
to allow time for this in class, in addition to the 200 minute data collection period. If you only
have one class period available, have your students charge and place the balloon immediately,
and then allow data collection to continue after the students have left. Analysis can then be
performed at another time.

6. Some televisions and computer monitors acquire a static charge, and so they collect dust
rapidly. If you have such a monitor you could use an alternative dust collection method.
Clean the monitor thoroughly, and then let it operate undisturbed for 45 minutes. Using a
clean piece of tissue or lens paper, wipe the screen clean with a small area of the paper. Use
this dust sample for the same experiment as described in the student activity. Do not use the
dust that has been on the screen for a long period, as it will represent a different equilibrium
population of radon progeny with a longer half-life.

7. Students often confuse the decay constant parameter λ with the half-life t1/2. The decay
constant λ is larger for more rapidly decaying elements and has dimensions of time–1, while
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the half-life has dimensions of time, and is smaller for more rapidly decaying elements. The
decay constant λ is equal to the fit parameter C in the Natural Exponential fit of Logger Pro
and LabQuest. The two parameters can be related in the following manner. After one half-life
has elapsed, half of the radioactive nuclei have decayed, and so the activity is also cut in half.
From the rate equation we can relate the decay constant to the half life.
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There is sufficient information in the student guide to perform this conversion, although some
students with weak algebra skills may have difficulty with it. You may choose to work
through this step with your students.

8. Since the dust sample collected by the balloon is not a single nuclear species decaying to a
stable state, the resulting decay curve is not a single exponential, but a sum of several related
exponential functions. The effective half-life measured here does not correspond to any one
decay element. The value numerical value of the effective half-life will depend on several
factors, including the length of time the balloon is allowed to collect dust and the time
between deflating the balloon and beginning data collection. For a 45-minute data collection
and a 3-minute delay before starting data collection, a typical half-life is about 40 minutes.

9. For counting measurements you can estimate the standard deviation of a set of measurements
using the square root of the number of counts. For example, if you measured a rate of
100 counts in five minutes, the standard deviation would be 10 counts in five minutes. The
standard deviation can be used as a measure of the uncertainty of a count rate measurement.

10. A longer version of this experiment can be found in Module 3, unit “Radioactivity and
Radon,” in theWorkshop Physics Activity Guide by Priscilla W. Laws (John Wiley & Sons,
1996). A spreadsheet model of the radon decay product series can explain the observed half-
life.

11. Note that the computer, LabQuest, and calculator versions of the activity use different
notation for the fitted equation. The calculator versions use seconds as the x-axis time unit, so
that the exponential fit parameter must be converted from s-1 to min-1 (s-1 = 60 min-1) to
obtain a lifetime in min-1.

12. If your radiation monitors have an audio mode (e.g., Digital Radiation Monitors), turning on
the audio function during the Preliminary Activity will provide an auditory indication of
counts in addition to the flash of the LED on the radiation monitor.
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SAMPLE RESULTS

ANSWERS TO PRELIMINARY QUESTIONS
1. Yes, there is radiation in the laboratory since the LED on the radiation monitor flashes with

no obvious source nearby. Since no source is apparent, there is no clear way as yet to
determine the source of the radiation.

DATA TABLE
Average background count rate in 5minutes 103

fit parameters for Y = A exp ( – C*X ) + B

A 454

B 97

C 0.0173

λ (min–1) 0.0173

t1/2 (min) 40

ANSWERS TO ANALYSIS QUESTIONS
1. Yes, the initial number of counts in a 5-minute interval is greater than the average background

rate by a factor of (five), which is a significant difference in terms of the standard deviation of
the count measurement. The count rate for the balloon-concentrated dust does decrease with
time.
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5. (number 4 for LabQuest and calculators) Since the fitted equation has an additive constant B,
there is no need to correct for the cosmic-ray background. The coefficients of the exponential
will reflect only the changing component of the count rates. The additive constant B from the
curve fit is nearly the same as the average background count rate without the balloon.

6. (number 5 for LabQuest and calculators) The measured half-life (40 minutes) is significantly
longer than any of the individual half-lives of the radon decay products. As a result we can
conclude that we are observing a combination of decays from several products.

7. (number 6 for LabQuest and calculators) Given a 40-minute half-life, we have
2-5*60/40 = 0.055, or about 6% of the initial activity remains after five hours. This does not
include the constant-rate background counts from sources other than the balloon.

8. (number 7 for LabQuest and calculators) Since the count rate from the balloon-concentrated
dust decreased in time, there must be some radioactive source in the environment other than
the constant-rate cosmic rays. Radon is a likely source since, as a gas, it can easily spread
from the soil.

9. (number 8 for LabQuest and calculators) If we assume that the radioactive dust collected by
the balloon consisted of radon decay products, then there must be a continuous introduction
of radon into the environment. If this were not the case, then the radon decay products would
have long ago decayed and we would not detect their radiation.

ANSWERS TO EXTENSIONS
1. Answers will vary, but unless there is a location with very high radon concentration, students

will generally find that the background count rate is independent of location within a single
community. On the other hand, if radon concentrations vary or if the building acts as a
significant cosmic ray shield, then the background will vary with location.

2. 222Rn (3.8 d) → 218Po (3.1 min) → 214Pb (27 min) → 214Bi (20 min) → 214Po (164 µs) →…
Radon decays by alpha emission, followed by alpha, beta, and then beta emission.

3. The additive constant should be small in comparison to its original value before background
subtraction.

4. A log plot of a single exponential function would be a straight line, with the slope equal to the
decay constant. Since these data roughly follow a straight line we can assign an effective
decay constant or half-life to the dust sample collected by the balloon. The points at longer
times will show significant scatter.

5 - 4 I Nuclear Radiation with Vernier



Background Radiation Sources

5. Since the dust sample collected by the balloon is not a single nuclear species decaying to a
stable state, the resulting decay curve is not a single exponential, but a sum of several related
exponential functions. The effective half-life measured here does not correspond to any one
decay element. The numerical value of the effective half-life will depend on several factors,
including the length of time the balloon is allowed to collect dust and the time between
deflating the balloon and beginning data collection.
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Computer6
Radiation Shielding

Alpha, beta, gamma, and X-rays can pass through matter, but can also be absorbed or scattered in
varying degrees depending on the material and on the type and energy of the radiation. Medical
X-ray images are possible because bones absorb X-rays more so than do soft tissues. Strongly
radioactive sources are often stored in heavy lead boxes to shield the local environment from the
radiation.

Some materials absorb beta rays. A sheet of common cardboard will absorb some of the betas,
but will allow most to pass through. You can measure this absorption by fixing a beta source and
a radiation monitor so their positions do not change, and then inserting layers of cardboard
between them.

When an absorber is in the path of beta rays, it will allow a certain fraction f to pass through. The
fraction f depends on the density and thickness of the absorber, but will be a constant for identical
absorbers and fixed beta ray energy. If the number of counts detected in a count interval is N0
when no absorber is in place, then the counts N with the absorber is N = f N0. In the preliminary
questions, you will develop a more general expression for additional layers of cardboard
absorbers, and then test it against real data.

In this experiment you will use a small source of beta radiation. Beta rays are high-energy
electrons. Follow all local procedures for handling radioactive materials.

OBJECTIVES
l Create a model for the absorption of radiation by matter.
l Use a radiation counter to study how the radiation emitted by a beta source is absorbed by
cardboard.

l Test the model against experimental data to determine its validity.

MATERIALS
computer
Vernier computer interface
Logger Pro
Vernier Radiation Monitor
strontium-90 1µC source taped to small support
ten 10 cm × 10 cm identical cardboard squares
adhesive tape
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PRELIMINARY PROCEDURE AND QUESTIONS
1. Place your Sr-90 source on a table. Connect the Radiation Monitor to a DIG port on your

interface and start the data-collection software if it doesn't start automatically. The LED on
the Radiation Monitor flashes as the monitor detects radiation. The LED will flash more
quickly when the monitor detects higher radiation level. By holding the monitor near the
source, determine the most sensitive place on the detector.

2. Attach the source disc to a support using adhesive tape so that the source held at the same
height as the Geiger tube in the radiation monitor. Do not cover the source with tape. Place
the source so it is about eight centimeters from the most sensitive place on the monitor, so that
there is room to place all ten layers of cardboard between the source and the monitor. It is
essential that neither the source nor the monitor move during data collection.

With only air between the source and the monitor, observe the flash rate for a short while.
Now place five layers of cardboard between the source and the monitor, taking care not to
move either one. Make observations again, and determine if the beep rate is larger, smaller, or
unchanged. Now add five more layers of cardboard, again not moving the source or monitor.
Observe and determine the change of the beep rate, if any. Does the cardboard seem to shield
the monitor from the beta radiation?

3. Based on your observations, sketch a qualitative graph of the flash rate vs. number of layers
of shielding.

4. In the introduction we used the expression N = f N0 to describe the transmission of betas by
one layer of cardboard. Assuming this model, how many counts would be detected if you
added a second layer of cardboard, identical to the first, which also transmitted a fraction f?
For example, if the first layer transmitted 90% of the radiation, then the second would
transmit 90% of that transmitted by the first. The overall transmission would then be
0.90 × 0.90 = 0.81 = 81% of the no-shielding number of counts. In the data table, write a
general expression for the number of counts N detected for any number x of identical layers,
each of which transmits a fraction f of the incident radiation. Use N0 as the counts detected
when no shielding layers are used. You have just developed a model for the transmission of
radiation through matter. Next you will test your model against experimental data.

5. Is your model consistent with your qualitative graph you sketched based on initial
observations? Remember than f is a number less than one. Add the model function to your
sketch without worrying about the vertical scale.

PROCEDURE
1. Connect the radiation monitor to a DIG port of the computer interface if it isn't already

connected.

2. Prepare the computer for data collection by opening “06 Shielding” from the Nuclear
Radiation w Vernier experiment files of Logger Pro. One graph is displayed: counts vs.
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layers. The vertical axis is scaled from 0 to 1000 counts/interval. The horizontal axis is
distance scaled from 0 to 10 layers.

3. Confirm that the source and monitor are positioned so they will not move, and so that there is
enough space between them for ten layers of cardboard. Remove all cardboard from between
the source and monitor.

4. Click to begin collecting data. Logger Pro will begin counting the number of beta
particles that strike the detector during each 50-second count interval.

5. After at least 50 seconds have elapsed, click . In the entry field that appears, enter 0,
which is the number of layers of cardboard. Complete your entry by pressing enter on the
keyboard. Data collection will now pause for you to adjust the apparatus.

6. Insert one layer of cardboard between the source and detector. Be sure that the cardboard
completely covers the source’s “view” of the Geiger tube in the detector. Click to
collect more data, and wait 50 seconds.

7. Click , and enter the new number of layers, 1.

8. In the same way as before, add a layer of cardboard without moving the source or monitor,
wait 50 seconds, and click . Enter the number of layers of cardboard. Click to
resume data collection. Repeat this process until you have completed data collection for ten
layers.

9. Click instead of to end data collection.

DATA TABLE
Model equation

Fitted equation with parameters

ANALYSIS
1. Inspect your graph. Does the count rate appear to follow your model?

2. Fit an appropriate function to your data. To choose a function, look for one that has the same
mathematical form as your model. To see the functions available, single-click the graph. Click
Curve Fit, . (Hint: Which fit functions have an x, the horizontal axis variable, in the same
special location as in your model equation?) Select an equation from the equation list, and
then click . A best-fit curve will be displayed on the graph. If your data follow the
selected relationship, the curve should closely match the data. If the curve does not match
well, try a different fit and click again. When you are satisfied with the fit, click

.

3. Print or sketch your graph. Record the fitted equation and parameters in your data table.
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4. From the evidence presented in your graph, does the transmission of beta radiation through
cardboard match that predicted by your model?

5. From the parameters of your fitted equation, determine the fraction f of beta rays transmitted,
on average, by one layer of cardboard. Do not use your raw data to calculate the fraction, but
instead use the better information from your fitted equation. Hint: Remember that A(Bx) = 
(AB)x.

EXTENSIONS
1. Use a longer counting interval so that you collect at least 2000 counts when no absorbing

cardboard is in place. Is the agreement with the model any different? Try a much shorter
count interval. How is the resulting graph different? Why?

2. Cosmic rays continue to strike the detector regardless of the absorbing cardboard. Measure
the average background counts in one count interval, and correct your data for background
radiation. Repeat the analysis.

3. Try other absorbers; for example, common household aluminum foil can be used in place of
cardboard. You will need to experiment with the appropriate number of layers to use. You
may want to add more than one (or five) layers at a time.
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LabQuest6
Radiation Shielding

Alpha, beta, gamma, and X-rays can pass through matter, but can also be absorbed or scattered in
varying degrees depending on the material and on the type and energy of the radiation. Medical
X-ray images are possible because bones absorb X-rays more so than do soft tissues. Strongly
radioactive sources are often stored in heavy lead boxes to shield the local environment from the
radiation.

Some materials absorb beta rays. A sheet of common cardboard will absorb some of the betas,
but will allow most to pass through. You can measure this absorption by fixing a beta source and
a radiation monitor so their positions do not change, and then inserting layers of cardboard
between them.

When an absorber is in the path of beta rays, it will allow a certain fraction f to pass through. The
fraction f depends on the density and thickness of the absorber, but will be a constant for identical
absorbers and fixed beta ray energy. If the number of counts detected in a count interval is N0
when no absorber is in place, then the counts N with the absorber is N = f N0. In the preliminary
questions, you will develop a more general expression for additional layers of cardboard
absorbers, and then test it against real data.

In this experiment you will use a small source of beta radiation. Beta rays are high-energy
electrons. Follow all local procedures for handling radioactive materials.

OBJECTIVES
l Create a model for the absorption of radiation by matter.
l Use a radiation counter to study how the radiation emitted by a beta source is absorbed by
cardboard.

l Test the model against experimental data to determine its validity.

MATERIALS
LabQuest
LabQuest App
Vernier Radiation Monitor
strontium-90 1µC source taped to small support
ten 10 cm × 10 cm identical cardboard squares
adhesive tape
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PRELIMINARY PROCEDURE AND QUESTIONS
1. Place your Sr-90 source on a table. Connect the Radiation Monitor to a DIG port on your

interface and start the data-collection software if it doesn't start automatically. The LED on
the Radiation Monitor flashes as the monitor detects radiation. The LED will flash more
quickly when the monitor detects higher radiation level. By holding the monitor near the
source, determine the most sensitive place on the detector.

2. Attach the source disc to a support using adhesive tape so that the source held at the same
height as the Geiger tube in the radiation monitor. Do not cover the source with tape. Place
the source so it is about eight centimeters from the most sensitive place on the monitor, so that
there is room to place all ten layers of cardboard between the source and the monitor. It is
essential that neither the source nor the monitor move during data collection.

With only air between the source and the monitor, observe the flash rate for a short while.
Now place five layers of cardboard between the source and the monitor, taking care not to
move either one. Make observations again, and determine if the beep rate is larger, smaller, or
unchanged. Now add five more layers of cardboard, again not moving the source or monitor.
Observe and determine the change of the beep rate, if any. Does the cardboard seem to shield
the monitor from the beta radiation?

3. Based on your observations, sketch a qualitative graph of the flash rate vs. number of layers
of shielding.

4. In the introduction we used the expression N = f N0 to describe the transmission of betas by
one layer of cardboard. Assuming this model, how many counts would be detected if you
added a second layer of cardboard, identical to the first, which also transmitted a fraction f?
For example, if the first layer transmitted 90% of the radiation, then the second would
transmit 90% of that transmitted by the first. The overall transmission would then be
0.90 × 0.90 = 0.81 = 81% of the no-shielding number of counts. In the data table, write a
general expression for the number of counts N detected for any number x of identical layers,
each of which transmits a fraction f of the incident radiation. Use N0 as the counts detected
when no shielding layers are used. You have just developed a model for the transmission of
radiation through matter. Next you will test your model against experimental data.

5. Is your model consistent with your qualitative graph you sketched based on initial
observations? Remember than f is a number less than one. Add the model function to your
sketch without worrying about the vertical scale.

PROCEDURE
1. Connect the Radiation Monitor to a DIG port of LabQuest if it isn't already connected.

Choose New from the File menu.
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2. Set up the data-collection mode.
a. On the Meter screen, tap Mode. Change the data-collection mode to Events with Entry.
b. Enter the Name (Layer) and leave the Units field blank.
c. Select OK.

3. Confirm that the source and monitor are positioned so they will not move, and so that there is
enough space between them for ten layers of cardboard. Remove all but one layer of
cardboard from between the source and monitor.

4. Start data collection. Tap Keep. The number of gamma photons that strike the detector will be
counted during the collection period.

5. After counting is complete, enter 1, the number of layers of cardboard. Save this data pair by
selecting OK.

6. Insert a second layer of cardboard between the source and detector. Be sure that the
cardboard completely covers the source’s “view” of the Geiger tube in the detector. Tap
Keep to start the next count interval.

7. When the interval is complete, enter the number of layers, 2, and select OK.

8. In the same way as before, add a layer of cardboard without moving the source or monitor,
and tap Keep to start counting. When counting is complete, enter the number of layers of
cardboard. Repeat this process until you have completed data collection for 10 layers.

9. Stop data collection when you are done collecting data.

DATA TABLE
Model equation

Fitted equation with parameters

ANALYSIS
1. Inspect your graph. Does the count rate appear to follow your model? How can you tell?

2. Fit an appropriate function to your data.
a. Choose Curve Fit from the Analyze menu.
b. Choose the equation that matches the mathematical form of your model as the Fit

Equation.
c. Record the fit equation and parameters in your data table.
d. Select OK.
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3. Print or sketch your graph.

4. From the evidence presented in your graph, does the transmission of beta radiation through
cardboard match that predicted by your model?

5. From the parameters of your fitted equation, determine the fraction f of beta rays transmitted,
on average, by one layer of cardboard. Do not use your raw data to calculate the fraction, but
instead use the information from your fitted equation. Hint: Remember that A(Bx) = (AB)x.

EXTENSIONS
1. Use a longer counting interval so that you collect at least 2000 counts when no absorbing

cardboard is in place. Is the agreement with the model any different? Try a much shorter
count interval. How is the resulting graph different? Why?

2. Cosmic rays continue to strike the detector regardless of the absorbing cardboard. Measure
the average background counts in one count interval, and correct your data for background
radiation. Repeat the analysis.

3. Try other absorbers; for example, common household aluminum foil can be used in place of
cardboard. You will need to experiment with the appropriate number of layers to use. You
may want to add more than one (or five) layers at a time.
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Experiment6
Radiation Shielding

1. See Appendix A for information about the word-processing files of the student experiments,
as well as any other electronic resources available for this book.

2. Calculator users: If you are collecting data with TI graphing calculators, an application such
as VST Apps or DataRad may need to be installed on the calculators. You can determine
which app you need at www.vernier.com/til/2672

The calculator instructions for this experiment are not intended for use with TI-Nspire
handhelds or computer software. Radiation Monitors cannot be used with color-screen TI-
84 Plus calculators (TI-84 Plus C Silver Edition and TI-84).

3. Sources are available from these suppliers:
l Spectrum Techniques: voice: (865) 482-9937, fax: (865) 483-0473,
www.spectrumtechniques.com

l Flinn Scientific: voice: (800) 452-1261, fax: (866) 452-1436, www.flinnsci.com

4. Because the radiation monitors detect individual particle arrivals, Poisson statistics apply. The
more counts that arrive in a counting interval, the better the precision. The standard error of a
count of n is n1/2, so do not be surprised to see considerable run-to-run variation in the many-
layer points where n is only ten or twenty. Longer count intervals are required to achieve
better precision.

5. This activity asks students to generalize the transmission through zero, one, two, three…
absorbers of f 0, f 1, f 2, f 3, to the transmission through x absorbers: f x.

6. It is critical that the geometry of the experiment remain constant as the absorbers are added. If
either the monitor or the source is moved during data collection, the resulting run will
probably be poor.

7. The final analysis question requires manipulating the fitted equation. Students who are weak
in mathematics may need assistance with this step.

8. The analysis asks that the student choose an appropriate fit equation based on the
mathematical form of the model. The model is an exponential function: N = f x N0. There are
two exponential functions offered in Logger Pro. One is a base-10 exponential function of
y = A*10^(B*x), or Y = A10Bx. Another is a natural exponential function of
y = A*exp(–C*x) + B, or Y = Ae–Cx + B. The different base of the exponential function does
not affect the shape of the function, but the natural exponential has the extra additive term of
“+ B.” Because the count rate is usually significantly higher than background, the additive
term will have little effect on the fit. As a result, either function could be chosen for this
experiment. The additive term does affect the fit slightly, however, so the exponential
parameter will not be directly comparable in the two fits (aside from the base change). Since
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the base 10 exponential more closely matches the form of the model developed by students, it
is the more natural choice, but either form can be used. The LabQuest and calculator
programs do not offer the base 10 choice.

9. The cardboard used for the sample data was cut from a standard cardboard shipping box. The
transmittance will vary with type and thickness of cardboard.

10. The strontium-90 source used in this activity is a pure beta source. No gamma rays are
emitted, so there is no confounding effect of differing absorption of gamma and beta radiation
by the shielding material.

11. If your radiation monitors have an audio mode (e.g., Digital Radiation Monitors), turning on
the audio function during the Preliminary Activity will provide an auditory indication of
counts in addition to the flash of the LED on the radiation monitor.

SAMPLE RESULTS
1. The model fits the experimental data well. The additional three points at lower left are

measures of background radiation from cosmic rays; the background count rate was small
compared to the count rate using the Sr-90 source.
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ANSWERS TO PRELIMINARY QUESTIONS
1. The screen at the end is the most sensitive spot.

2. Yes, the cardboard appears to shield the radiation monitor from the beta radiation of the
Sr-90 source. Adding more layers of cardboard further reduces the count rate.

3. Graph is a decreasing function with additional layers of cardboard.

4. N = N0 f x, where f is the fraction of beta particles transmitted by one layer, and x is the
number of layers.

5. Model function is also a decreasing function with additional layers x, since f is less than one.

DATA TABLE
Model equation N = N0 f x

Fitted equation with parameters Y = 1870 × 10(–0.141 x)

ANSWERS TO ANALYSIS QUESTIONS
1. The count rate falls off rapidly with added absorbers. This is consistent with the model, which

predicts reduced rates with increased numbers of absorbing layers.

4. Yes, the experimental data match the model fairly well, especially for the larger numbers of
layers of absorbers. It appears that the simple multiplicative model does predict the
transmission of radiation through matter.

5. (computer data) Using the base-10 fit, and noting that 10Bx corresponds to f x, we have
10B = f. So, 10–0.141 = 0.72. One layer of cardboard (of the type used for the sample data)
transmits 72% of the beta particles striking it.

(calculator data) Noting that e-Bx corresponds to fx, we have e-B = f. So, e–0.39 = 0.68. One
layer of cardboard (of the type used for the sample data) transmits 68% of the beta particles
striking it.

ANSWERS TO EXTENSIONS
1. For longer collection times, the total number of counts in each interval will be longer. As a

result, the precision of each measurement will be greater. We would expect less scatter about
the model line. For shorter collection times, the precision will be reduced and we would see
more scatter about the model’s function.
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2. The sample data show three points below the main curve. These are background counts made
with no source. The average was approximately 25 counts in each 50-second count interval.
To correct for background radiation, subtract 25 from each of the data points collected using
the source and the absorbers, and repeat the graphing and fits.

3. One layer of foil absorbs a much smaller fraction of the betas, so larger stacks of absorbers
will be required. You may want to use ten layers of foil in place of each single layer of
cardboard.
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Using the Electronic Resources 

The electronic resources, accessed through your account at www.vernier.com, contain the 
following:   

 Instructor–Contains the instructor information pages for each experiment in this book. 

 Student  

 EasyData–Contains the EasyData instructions for each of the student experiments in this 
book. 

 LabQuest–Contains the LabQuest App instructions for each of the student experiments in 
this book.  

 Logger Pro–Contains the computer instructions for each of the student experiments in 
this book.  

 Word Files for Older Book–These are the word-processing files for each of the six student 
computer-based experiments in the book Nuclear Radiation for Computers and Calculators, 
First Edition. They use Logger Pro 2 computer software with LabPro or ULI. 

Nuclear Radiation with Vernier Word-Processing Files 
These files provide a way for you to edit student experiments to match your lab situation, your 
equipment, or just your style of teaching. They contain all figures, text, and tables in the same 
format as printed in this book.  
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AppendixB
Radiation Monitor Models

Over time, Vernier has sold different models of the radiation monitor. Variations include the
shape and color of the body and the presence (or lack there of) of a power switch. Information
about how to determine which model you have can be found in this appendix.

This book was written to support the current version of the radiation monitor, the Vernier
Radiation Monitor (order code: VRM-BTD). However, if you have other models, you can still
successfully complete the all the experiments. If you are using LabQuest App and have radiation
monitors that do not auto-ID, you will also need to tell students how to set up their sensors in the
software. The setup steps are included in this appendix. If you want to include the setup steps in
the student pages, see Appendix A for information about editing the Word files of the
experiments.

Description of models

Vernier RadiationMonitor (current model, order code: VRM-BTD)
l Appearance: Black tube with two orange bands
l Power switch: No
l Measures: alpha, beta, gamma, X-ray
l Auto-ID in software: Yes, when used with LabQuest

RadiationMonitor (discontinued, order code: RM-BTD)
l Appearance: Brown box with analog meter
l Power switch: No
l Measures: alpha, beta, gamma, X-ray
l Auto-ID in software: No

Digital RadiationMonitor (discontinued, order code: DRM-BTD)
l Appearance: Black box with digital meter
l Power switch: Yes
l Measures: alpha, beta, gamma, X-ray
l Auto-ID in software: Yes, when used with LabQuest

Student RadiationMonitor (discontinued, order code: SRM-BTD)
l Appearance: Black box (no meter)
l Power switch: No
l Measures: beta, gamma, X-ray
l Auto-ID in software: No
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Detector location

Vernier RadiationMonitor (order code: VRM-BTD)
The metal screen at the end of the tube is the most sensitive surface of the Vernier Radiation
Monitor. Place the source near the metal screen. Measure all distances from the center of the
metal screen, perpendicular to the screen

RadiationMonitor (order code: RM-BTD)
The metal screen at the end of the box is the most sensitive surface of the Radiation Monitor.
Place the source near the metal screen. Measure all distances from the center of the metal screen,
perpendicular to the screen.

Digital RadiationMonitor (order code: DRM-BTD)
The metal screen at the end of the box is the most sensitive surface of the Digital Radiation
Monitor. Place the source near the metal screen. Measure all distances from the center of the
metal screen, perpendicular to the screen.

Student RadiationMonitor (order code: SRM-BTD)
The most sensitive place on the Student Radiation Monitor is the clear window on the underside
of the monitor. When measuring, stand the case on edge, with the Geiger Tube window near the
table. Measure distances from the middle of this window, perpendicular to the window

Configure non-auto-ID radiation monitors (LabQuest)

This step is only necessary for data collection with LabQuest. It works for all radiation monitors
that do not auto-ID.

1. Connect the radiation monitor to a DIG port of LabQuest. Choose New from the File menu.
If you have an older sensor that does not auto-ID, manually set it up:
a. Choose Sensor Setup from the Sensors menu.
b. Select Radiation Monitor from the DIG 1 sensor list.
c. Select OK.
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AppendixC
Transferring Data

You may elect to transfer data from LabQuest or a TI graphing calculator to a computer using
Logger Pro software. Logger Pro has many graphing features, such as bar graphs, labels and
units for axes, and modification of axes values. Additionally, printed graphs will have a better
resolution and appearance than printed screens of the LabQuest or TI graphing calculator display.
Logger Pro also provides advanced data-analysis features, such as advanced curve fitting,
statistical analysis, and calculated spreadsheet columns.

Transferring Data from LabQuest to Logger Pro

1. Save the file on LabQuest.
2. Connect LabQuest to your computer with a USB cable.
3. Start Logger Pro on your computer.
4. Choose LabQuest Browser ► Open… from the File menu in Logger Pro.
5. Select the file name you want, and then click Open. Logger Pro will open the LabQuest file,

and display any data, graphs, and notes.

Transferring Data From a TI Graphing Calculator to Logger Pro

1. Connect the TI unit-to-computer cable or the TI Connectivity cable to the USB port of your
computer and to the appropriate port on the calculator.

2. Turn on the calculator.
3. Start Logger Pro on your computer.
4. Choose Import from►TI Device from the File menu in Logger Pro. A dialog box appears

with directions for importing data.
5. From the drop-down Port menu, make the appropriate choice for your connection.
6. Click the Scan for Device button. The calculator model you are using should now be

identified, and you should see a message, “Ready to Import.”
7. Select the lists that you wish to import by clicking each of them. Note: To select more than

one list on a Macintosh, drag your cursor across the desired lists or hold down the Command
key while you click to select individual lists.

8. Click OK to send the lists to the computer. The lists will appear in columns in the data table
in Logger Pro. If you want to rename the lists or add units, double-click the heading in the
data table and enter new labels or units.
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AppendixD
Vernier Products for Use

with this Book
The Vernier Software & Technology and Texas Instruments products that can be used to perform
experiments in Nuclear Radiation with Vernier are described in this appendix.

Data-Collection Interfaces for this Book
LabQuest 2

Vernier LabQuest 2 provides a portable and versatile data-collection device for any class. It can
be used as a computer interface, as a standalone device, or in the field. It has built-in graphing
and analysis software and a vivid color touch screen. It is compatible with existing Vernier
sensors. It has a rechargeable, high-capacity internal battery. It also has a built-in temperature
sensor, microphone, light sensor, 3-axis accelerometer, and GPS.

LabQuest Mini

The Vernier LabQuest Mini is a low-cost data-collection interface that connects to the USB port
of a computer and has five sensor ports.

CBL 2

Texas Instruments CBL 2 is a portable and versatile data-collection device. A wide variety of
Vernier probeware can be connected to the three analog channels and one digital/sonic channel
of the CBL 2. The CBL 2 is connected to a TI calculator through the port on the calculator.
Because the CBL 2 is battery powered, it can be taken in the field.

Data-Collection Software for this Book
Computer

Logger Pro is the data-collection software for collecting data on a computer. Logger Pro
software comes with a site license for both Windows and Macintosh. It is available for download
from the Vernier website, www.vernier.com

LabQuest

LabQuest App is the data-collection application used to collect data when using LabQuest or
LabQuest 2 as a standalone device.

Calculator

The DataRad data-collection program is the data-collection program used for collecting data with
a calculator.
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